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Introduction

Welcome to your Visual Basic support package. That s what this book has been
designed to be: your complete VB support package. Have we reached that goal yet? It
s up to you to decide. If what you relooking for is not in this edition, we || work hard
to make sure it sin the next | encourage your suggestions. Please feel free to write.
Well put in the time to make sure this book is the most complete one available on
Visual Basic, edition after edition. Thisisthe book we want you to come back to
again and again.

| ve used Visual Basic back before version 1 even came out publicly and have written
many books on the program. | put Visual Basic to work for avery wide range of uses
day after day; in fact, it sis my favorite programming package of all, and it comes
close to being my favorite program period. But | ve never written a book on Visual
Basic as complete as this one and never included as many features, documented or
undocumented, examples, and tips in one volume.

This book has been designed to give you the coverage you just won t find in any other
book. Other books often omit not only the larger topics, like deploying your program
after you ve created it and creating Help files, but also the smaller ones, like covering
in depth just about every control that comes with Visua Basic, including the ActiveX
controls from the M S chart control to flat scroll bars, from the serial port comm
control to the Internet transfer control.

Reluctantly, | must admit that it s impossible for one volume to be utterly
comprehensive on the subject of Visual Basic (impossible because it s not physically
possible to bind a book that big yet), but we re trying our best. It s true that some
specialty books might have more coverage on afew topics, but if you want to see
more on a particular topic, writein and we || work seriously on adding more of that
topic to the next edition.

How ThisBook Works

The task-based format we use in this book is the one most programmers appreciate
because programming is a task-based business. Rather than reading about subjectsin
the order the author thinks best, you can go directly to your topic of interest and find
the bite-sized nugget of information you need, such as opening an FTP connection,
adding a Web browser to your program, supporting online user registration from
Visual Basic, adding a method to an ActiveX control, creating an error handler,
flipping or stretching an image, opening an RDO database connection, playing CDs
from the computer s CD-ROM drive, and literally hundreds of other topics.

And best of all, there saworking example in code for amost every programming
topic in the book. The actual process of programming is not abstract; it s very applied.
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So instead of vague generalities, we get down to the specifics all the specifics that
give you everything you need to understand and use Visual Basic.

In the old days, programming books used to be very top-down, with chapters on
subjects like conditional branching, loop structures, variable declarations, and so
forth. But who sits down to program by saying, | m about to create a conditional
program flow branch ? Instead, programmers are more interested in performing useful
tasks, like adding buttons, menus, list boxes, or toolbars to a window; creating
graphics animation; creating dialog boxes; creating setup programs; working with
files; supporting online Help; and so on. And this book is written for programmers.

Because this book is written for programmers, each chapter is broken up into dozens
of practical programming tasks. After selecting the chapter you want, you can turn to
the table of contents, or to the first page in that chapter, to find the task you re
interested in. Hundreds of tasks are covered in this book, chosen as those that
programmers most want to see. In addition, this book isfilled with nearly 800
examples, covering just about every Visual Basic programming areathereis. These
examples are bite-sized and to the point, so you don t have to wade through a dozen
files trying to understand one simple topic. And they re as comprehensive as we could
make them, covering every programming area in the book.

Besides programming tasks and examples, the book also has overviews designed to
bring all the pieces together into a coherent whole, giving you the entire picture. The
first chapter is designed specifically to give you an overview of Visual Basic itself,
along with some of the best programming practices to use, including those
recommended by Microsoft. Every subsequent chapter starts with an overview of the
subject it covers before digging into the specifics, making sure we never get lost in
details. We Il also see discussions on best programming practices, program design,
program testing, what makes a professional Windows application professional, and
much more, as befits a book that wants to be your complete Visual Basic support
package. In addition, the CD that accompanies this book holds the code for all the
major projects we develop. To open and use a project, look for the Visual Basic
project file (for example, browser.vbp for the browser project) and open that project
filewith Visual Basic.

Besides the code from the book, note that the CD has hundreds of megabytes of tools
and software, ready for you to use.

What sIn This Book

Just about everything we could write about Visual Basic isin this book, and that sa
lot of ground to cover. From language reference to ADO database handling, from
creating Web browsers to dragging and dropping data across applications, from email
applications to multimedia players, from creating ActiveX controls and ActiveX
documents to setup programs, it sall here.

Here s some of what we |l see how to create in this book:

" ActiveX controls
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" ActiveX documents

ADO, DAO, and RDO database applications
Multimedia AVI, MPG, WAV, and MID players

' CD playersthat play CDs from the computer s CD-ROM drive

Bitmapped menu items

Full Web browsers

" Piecharts, line charts, bar charts, and others

Code clients that call methods in programs like Microsoft Excel

Code components (OL E automation servers)

' Graphics animation

Applications that use the Windows Common Dialogs

Customized toolbars with embedded controls like combo boxes

' Dataentry forms

Database editing applications

Direct connections to the Windows API

" Direct connections to code written in Visual C++

Drag/drop operations

Graphics applications that draw arcs, circles, rectangles, lines, and more

' Emalil applications

Error handlers

Applications that use the printer

" Word processor applications

File handlers for text and binary data

FTP applications

' Diaog boxes

Windows Help files
MDI applications

" Pop-up menus activated with right mouse clicks
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' Application deployment

HTTP applications

" Image handling: blur, emboss, engrave, flip, sweep, stretch images, and more
' OLE applications

" Applications that use the Windows Registry

List views and tree views

' Applications that create controls at runtime

Mouse capture

" OLE drags (dragging data between applications)
' Online user registration

Picture clip applications

Setup programs
' Screen capture

" Spreadsheets

" Status bars and toolbars
' Tab strips, progress bars, and others

That s just some of what scoming up. Visual Basic isavery large topic, and the
topics we Il cover number in the hundreds. And if you have suggestions for more,
please send them in.

What You Il Need

To use this book profitably, you should have some experience with Visual Basic not
necessarily alot, but enough to get through Chapter 1 without trouble. We assume you
have some familiarity with the essentials of Visual Basic in this book, although those
essentials are not very hard to pick up. If you do have trouble with Chapter 1, you
might take alook at an introductory book before proceeding.

Asfar as software goes, just about all you need to use thisbook is already in
Microsoft Visual Basic (well use version 6 in this book). Visual Basic comes with an
enormous set of tools and resources, and we Il have our hands full putting them to
work.

We try to be as self-contained in this book as possible even creating the database files

we | use in examples with Visual Basic itself, not with a database application. The

graphics files we use in various examples are on the CD, and the multimedia files we
Il play in our multimedia examples come with Windows. Some of our OLE and OLE
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automation examples use Microsoft Excel, but Excel is not essential to those
examples any OLE server and OLE automation server program will do. Note that to
use email from Visual Basic, you must have the Windows MAPI system installed (as
represented by the Inbox icon on the Windows desktop).

Where can you go for additional Visual Basic support? Y ou can find Visual Basic
user groups all over, and more are appearing every day. You can also find Visual
Basic information (and advertising) at the Microsoft Visual Basic home page at
www.microsoft.com/vbasic/, free Visual Basic downloads at
http://www.microsoft.com/vbasi ¢/download/, and technical documents (white papers)

at http://www.microsoft.com/vbasi c/techmat/.

Although the content varies in accuracy, there are many Usenet groups dedicated to
Visual Basic aswell, but be careful what you read there there s no guaranteeit s
accurate. About two dozen of those groups are hosted by Microsoft, including:

microsoft.public.vb.bugs

" microsoft.public.vb.addins
microsoft.public.vb.controls
microsoft.public.vb.database

" microsoft.public.vb.installation
microsoft.public.vb.ole
microsoft.public.vb.ole.automation
" microsoft.public.vb.syntax

Other, non-Microsoft groups include some of these popular Usenet forums:
comp.lang.basic.visual

' comp.lang.basic.visual.3rdparty
comp.lang.basic.visual .announce
comp.lang.basic.visual .database

' comp.lang.basic.visual.misc

And that all the introduction we need it stime to start digging into Visual Basic. As
we ve said, we intend this book to be your complete support package for Visual Basic,
S0, again, if you see something that should be covered and isn t, let us know. In the
meantime, happy reading!
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What s On The CD-ROM

The companion CD-ROM contains the source code and project files used in the Visual
Basic 6 Black Book.

Also included are demo copies of the following programs:

' CoffeeCup HTML Editor++ 98 An HTML editor with built in Java and animated
GIFs.

' CoffeeCup ImageMapper++ A fully functional image mapper.

Site Sweeper Program that provides an automatic, comprehensive analysis of your
Web site.

" QuickSite

" SQL-Station

' Setup Factory
AutoPlay Menu Studio
" VBAdvantage

' OlectraResizer

" Q-Diagnostic Software
Requirements

To run al the projects discussed in the book, you will need to have Visua Basic 6
installed.

Platform

486 or higher processor
Operating System
Windows 95, 95, or NT
RAM

16MB
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Chapter 1
Visual Basic Overview

Welcome to our big book on Visual Basic. It s no secret that Visual Basic isthe
favorite programming environment of many programmers. (In fact, you rereading a
book written by one of those programmers right now.) When Visual Basic first
appeared, it created a revolution in Windows programming, and that revolution
continues to this day. Never before had Windows programming been so easy just
build the program you want, right before your eyes, and then run it. Visual Basic
introduced unheard-of ease to Windows programming and changed programming
from a chore to something very fun.

In time, Visual Basic has gotten more complex, as well as more powerful. In this
book, we re going to see how to use Visual Basic in atask-oriented way, which is
the best way to write about programming. Instead of superimposing some abstract
structure on the material in this book, we Il organize it the way programmers want it
task by task.

This book assumes you have some familiarity with Visual Basic; when you use this
book, you Il usually have some task in mind setting a program s startup form, for
example, or optimizing for a specific processor and this book will provide the
answer. Well try to be as complete as possible (unlike the frustrating recordings of
frequently asked questions which never seem to address your particular problem
you can access while on hold for tech support). Thisbook is designed to be the one
you come back to time and time again. It s not just to learn new techniques, but it is
also to reacquaint yourself with the forgotten details of familiar methods.

Wel ll start with an overview of Visual Basic, taking alook at topics common to the
material in the rest of the text. In this chapter, we Il create the foundation well rely
on later as we take alook at the basics of Visual Basic, including how to create
Visual Basic projects and seeing what s in such projects. We ll also get an overview
of essential Visual Basic concepts like forms, controls, events, properties, methods,
and so on. And we |l examine the structure of aVisual Basic program, taking alook
at variables, variable scope, and modules. In other words, we re going to lay bare
the anatomy of aVisual Basic program here.

Well aso take alook at programming practices common to all Visual Basic
programs. This overview chapter is the place to take alook at those practices
because they involve the rest of the book.

Most Visual Basic programmers do not have formal programming training and have
to learn alot of this material the hard way. As programming has matured,
programmers have learned more and more about what are called best practices the
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programming techniques that make robust, easily debugged programs. Well take a
look at those practices in this chapter, because they are becoming more and more
essential for programmers in commercia environments these days, especially those
programmers that work in teams. And we ll look at those practices from the
viewpoint of programmers who program for aliving; frequently there sagap
between the way best practices are taught by academics and how they are actually
needed by programmers facing the prospect of writing a 20,000-line program as part
of ateam of programmers.

We ll start our overview chapter by creating and dissecting a Visua Basic project,
jumping right into the code.

Creating A Project In Visual Basic

There are three different editions of Visual Basic:

' The Learning Edition, which is the most basic edition. This edition allows you to
write many different types of programs, but lacks a number of tools that the other
editions have.

" The Professional Edition, designed for professionals. This edition contains all
that the Learning Edition contains and more, such as the capability to write ActiveX
controls and documents.

" The Enterprise Edition, which is the most complete Visual Basic edition. This
edition istargeted towards professiona programmers who may work in ateam and
includes additional tools such as Visual SourceSafe, a version-control system that
coordinates team programming.

We ll use the Enterprise Edition in this book, so if you have either of the other two
editions, we might occasionally use something not supported in your Visual Basic
edition. Well try to keep such occurrences to a minimum.

Start Visual Basic now, bringing up the New Project dialog box, as shown in Figure
1.1

Figure 1.1 Creating anew Visual Basic project.

In Figure 1.1 you see some of the project typesthat Visual Basic supports:
" Standard Windows EXE programs
' ActiveX EXEfiles

" ActiveX DLLs

ActiveX controls

' Programs written by the Visual Basic Application Wizard
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' Data projects

I1S (the Microsoft Internet Information Server) applications
" Visua Basic add-ins

' ActiveX document DLLs

" ActiveX document EXE files

" DHTML applications

' VB Enterprise Edition controls

Thislist of project types indicates some of the ways Visual Basic has grown over
the years. Asyou can see, there sawhole galaxy of power here (and we |l cover that
galaxy in this book). In this case, we just want to take alook at the basics of a
standard Visual Basic project, so double-click the Standard EXE item in the New
Project dialog box, opening Visua Basic itself. Figure 1.2 showsthe Visual Basic
Integrated Development Environment (IDE). (We re going to cover al parts of the
Visual Basic Integrated Development Environment in the next chapter here, well
just use it to create our first project.)

Figure 1.2 A new Visual Basic project.

For our first example, we might create a small tic-tac-toe program using nine
buttons in aform, as shown in Figure 1.3.

Figure 1.3 Designing our first project.

When the user clicks a button, we can display an x in the button s caption, as
shown in Figure 1.4.

Figure 1.4 Clicking a button in the tic-tac-toe program to display an X .

If the user clicks another button, we can display an o, and so forth.

This example will create a program that lets us take alook at Visual Basic projects,
controls, control arrays, events, properties, coding, variables, and variable scope.
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Designing The Tic-Tac-Toe Program

Using the Command Button tool in the Visual Basic toolbox, add a new command
button to the main form in our program now, as shown earlier in Figure 1.2. Next,
in the Properties window, change the Name property of this button from
Command1l to Command in preparation for setting up a control array, and clear its
Caption property so the button appears blank.

Next, add a second button to the form, and set its Name property to Command as
well. When you do, Visual Basic opens adialog box that states. Y ou already have a
control named Command . Do you want to set up acontrol array? Click Yesto
create a control array, which means we will be able to refer to our controls using an
index instead of simply by name.

Add atotal of nine buttonsto the main form in our program, arranged in a 3x3 grid
similar to a standard tic-tac-toe game, give each of the buttons the name Command,
and clear their captions. That completes the preliminary design now we re ready to
write some code.

Coding The Tic-Tac-Toe Program

In this program, we |l toggle button captions between x and o. To start coding,
double-click any button, opening the code window, as shown in Figure 1.5.

Figure 1.5 Using the Visual Basic code window.

Double-clicking a button creates an event handler subroutine named
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Command_Click() and opens that subroutine in the code window:
Private Sub Command_Cick(1lndex As Integer)

End Sub

Visual Basic programs like this one are centered around events, and most events
occur when the user triggers them. In this case, a Click event istriggered when the
user clicks abutton, and we re passed the button sindex in the control array of
buttons as the I ndex parameter in Command_Click(), as with this line of code
from the earlier snippet:

Private Sub Conmmand O i ck(1ndex As |nteger)

When the user clicks a button, we need to know which character to display, and we
Il keep track of that in aform-wide variable named xNow; if xNow is True, we
should display an x, if False, an o.

To add that form-wide variable, click the (General) entry in the left drop-down list
box in the code window, and add this code to the general section of our form:

Di m xNow

Y ou can indicate the type of avariable when declaring it with Dim to indicate that
XxNow is a Boolean variable, we could declareit this way:

Di m xNow As Bool ean

(Declaring it without atype makesit a variant, which meansit can operate as any
type of variable.) The possible variable types and their ranges appear in Table 1.1.

Tablel1l.1
Variable
types. Bytes
Variable Of
Type Storage
Range
Boolean 2 Trueor False
Byte 1 0to 255
Currency 8 -922,337,203,685,477.5808 to 922,337,203,685,477.5807
Date 8 1 January 100 to 31 December 9999 and times from 0:00:00
to 23:59:59
Decimal 12 -79,228,162,514,264,337,593,543,950,335 to

79,228,162,514,264,337,593,543,950,335
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Double 8 -1.79769313486232E308 to 4.94065645841247E-324 for
negative values and from 4.94065645841247E-324 to
1.79769313486232E308 for positive values

Integer 2 -32,768 to 32,767
Long 4 -2,147,483,648 to 2,147,483,647
Object 4 N/A
Single 4  -3.402823E38 to -1.401298E-45 for negative values and from

1.401298E-45 to 3.402823E38 for positive values
String N/A A variable-length string can contain up to approximately 2
billion characters; afixed-length string can contain 1 to
approximately 64K characters
User-defined N/A N/A
datatype
Variant N/A  N/A

We need to initialize that form-wide variable, xNow, and we do that when the form
first loads in the Form_L oad() procedure, which is run when the form isfirst
loaded. Open that procedure now by selecting the Form item in the code window s
left drop-down list box, or by double-clicking the form itself; here, we just initialize
xNow to True:

Private Sub Form Load()
xNow = True
End Sub
Now we will toggle the clicked button s caption depending on the current setting of

xNow. To reach the clicked button in Command_Click(), we use the control array
index passed to us this way:

Private Sub Conmmand O ick(1ndex As |nteger)

| f xNow Then
Command( | ndex) . Caption = "x"
El se
Command( | ndex) . Caption = "o"
End | f
End Sub

Finally, we toggle xNow (from True to False or False to True) thisway:

Private Sub Command_Cick(lndex As I|Integer)
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| f XNow Then

Command( | ndex) . Caption = "x"
El se

Command( | ndex) . Caption = "o"
End | f

XxNow = Not XxNow

End Sub

And that sall we need the tic-tac-toe program is complete. Run it now, as shown in
Figure 1.6, and click afew buttons. The captions toggle between x and o as they
should.

Figure 1.6 Running the tic-tac-toe program.

It snot avery exciting program as it stands, of course, because it was just designed
to give us alook into how Visual Basic projects work. Now we || take a closer look
at the parts of a project, starting with the one we ve just created.

The Parts Of A Visual Basic Project

Projects can become quite advanced in Visual Basic, even containing subprojects of
different types. From a programming point of view, however, standard Visual Basic
projects usually contain just three types of items: global items, forms, and modules,

asoutlined in Figure 1.7.

Figure 1.7 The parts of a Visual Basic project.

Forms

Forms are familiar to all Visual Basic programmers, of course they re the templates
you base windows on. Besides standard forms, Visual Basic also supports Multiple
Document Interface (MDI) forms, as well as a whole number of predefined forms
that we Il see in the next chapter.
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Modules

Modules are collections of code and data that function something like objectsin
object-oriented programming (OOP), but without defining OOP characteristics like
Inheritance, polymorphism, and so on. The point behind modulesis to enclose
procedures and datain away that hides them from the rest of the program. Well
discuss the importance of doing thislater in this chapter when we cover Visual
Basic programming techniques and style; breaking alarge program into smaller,
self-contained modules can be invaluable for creating and maintaining code.

Y ou can think of well-designed modules conceptually as programming objects; for
example, you might have a module that handles screen display that includes a dozen
internal (unseen by the rest of the program) procedures and one or two procedures
accessible to the rest of the program. In thisway, the rest of the program only hasto
deal with one or two procedures, not a dozen.

Besides modules, Visual Basic aso supports class modules, which we |l seelater in
this book when we discuss how to create ActiveX components in Chapter 20.
Programming with class modules will bring us much closer to true OOP
programming.

Global Items

Global items are accessible to al modules and formsin a project, and you declare
them with the Public keyword. However, Microsoft recommends that you keep the
number of global items to an absolute minimum and, in fact, suggests their use only
when you need to communicate between forms. One reason to avoid global
variablesistheir accessibility from anywhere in the program; while you re working
with aglobal variable in one part of a program, another part of the program might
be busy changing that variable, giving you unpredictable results.

Now that we ve gotten an overview of the mgjor parts of a project, we |l take alook
at how the parts of a project interact, which brings up the idea of scope, or visibility
In a project.

Project Scope

An object s scope indicates how much visibility it has throughout the project in the
procedure where it s declared, throughout aform or module, or global scope (which
means it s accessible everywhere). There are two types of scope in Visual Basic
projects. variable scope (including object variables) and procedure scope. We ll take
alook at both of them here as we continue our overview of Visua Basic projects
and how the parts of those projects interact.

Variable Scope
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Y ou declare variables in a number of ways. Most often, you use the Dim statement
to declare avariable. If you do not specify the variable type when you use Dim, it
creates a variant, which can operate as any variable type. Y ou can specify the
variable type using the As keyword like this:

Dim I ntegerVal ue As I nteger

Besides Dim, you can also use ReDim to redimension space for dynamic arrays,
Privateto restrict it to amodule or form, Public to make it global that is, accessible
to all modules or forms or Static to make sure its value doesn t change between
procedure calls. These ways of declaring variables are summarized in Table 1.2.

Table1.2
Visual
Basic
declaring poes This
statements.
Keyword
Dim Using Dim alone creates variants. Use the As keyword to specify
variable type.
Private Makes variable available only in the current form/module.
Public Makes variable global variable is available to the rest of program.
ReDim Reallocates storage space for dynamic array variables.
Static Variable preserves its value between procedure calls.

Type Declaresauser type.

There are three levels of variable scopein Visual Basic: at the procedure level, at
the form or module level, and at the global level. Schematically, Figure 1.8 shows
how project scope works.

Figure 1.8 Schematic of Visual Basic project scope.

When you re designing your program, Microsoft suggests you limit your variables
to the minimum possible scope in order to make things simpler and to avoid
conflicts. Next, we |l take alook at the other type of scope: procedure scope.

Procedur e Scope

Aswith variables, you can restrict the scope of procedures, and you do that with the
Private, Public, Friend, and Static keywords. The Private and Public keywords
are the main keywords here; using them, you can specify if a subroutine or function
Is private to the module or form in which it is declared or public (that is, global) to
all forms and modules. Y ou use these keywords before the Sub or Function
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keywords like this:

Private Function Returns7()
Di m Ret val
Retval =7
Returns7 = Retval

End Functi on

Y ou can also declare procedures as friend procedures with the Friend keyword.
Friend procedures are usually used in class modules (they are not available in
standard modules, athough you can declare them in forms) to declare that the
procedure is available outside the class, but not outside the current project. This
restricts those functions from being called if the current project servesasan OLE
automation server, for example.

Besides the earlier declarations, you can also declare procedures as Static, which
means that the variables in the procedure do not change between procedure calls,

and that can be very useful in cases like this, where we support a counter variable
that isincremented each time afunction is called:

Static Function Counter()
Di m Count er Val ue as | nt eger
Count erVal ue = CounterValue + 1
Count er = Count er Val ue

End Sub

That completes our overview of projectsin memory now we ve seen how such
projects are organized, what parts they have, and what scope their parts have. Well
take alook at storing projects on disk next.

Projects On Disk

Now that we ve created our first project the tic-tac-toe project we |l save it to disk.
Turn to Visual Basic now and select the Save Project Asitem in the Visual Basic
File menu to save our new project to disk.

Visual Basic first saves the files associated with the project, and places a Save File
As dialog box on the screen to save the program s form, which Visual Basic gives
the default name of Form1.frm. Change that name to tictactoe.frm now, and save it
to disk (in this book, we |l save projectsin the C:\vbbb directory, so this project will
go into the C:\vbbb\tictactoe directory).
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This completes our overview of the standard parts of a standard Visual Basic project. We ve seen how
simple projects work in Visual Basic now. Besides this simple kind of project, you can design quite
advanced projects using atool like the Visual Basic Application Wizard, and we || take alook at that now.

Using The Visual Basic Application Wizard

The Visua Basic Application Wizard isa Visual Basic add-in that lets you use some advanced project
features when you first create a project. The Application Wizard is usually used by beginning
programmers, but we |l take alook at it here to get an idea of what more involved projects can look like.

Y ou start the Application Wizard from the New Project box, opened either from the New item in the File
menu or when Visual Basic first starts. The Application Wizard appears in Figure 1.10.

Figure 1.10 The Visual Basic Application Wizard.

TIP: InFigure 1.10, the Application Wizard is asking for a profile. Y ou can save Application Wizard
profiles (something like project templates) in the last step of the Application Wizard, which lets you save
all the options you ve specified. Loading them in later can save you sometime if you just want to alter a
few settings.

Click the Next button in the Application Wizard now, opening the next screen, shown in Figure 1.11. The
Multiple Document Interface (MDI) option is already selected, and we Il leave it selected. Click the Next
button to move to the next screen.

Figure 1.11 Selecting MDI support in the Visual Basic Application Wizard.

The next screen lets you select menu options, the next screen toolbar options, and the one after that
resource options. Keep clicking Next to accept all the defaults. The Internet Connectivity screen, which
opens next, lets you add a Web browser window to your project if you like. This can be very useful, so
click Yesas shown in Figure 1.12, then click Next again to move on.

Figure 1.12 Adding a\Web browser with the Visual Basic Application Wizard.

The next step in the Application Wizard, as shown in Figure 1.13, lets you add a splash screen. A splash
screen comes up while the program is loading and can give the impression that something isreally
happening while the program is loaded. We add a splash screen to our program by selecting the Splash
Screen At Application Start Up option.
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Figure 1.13 Adding a splash screen with the Visual Basic Application Wizard.

TIP: Originaly, splash screens were very popular in fact, virtually every piece of Microsoft software has
one these days but users are catching on that they are just razzle-dazzle.

The next screen asks about database connectivity; click Next to open the last Application Wizard screen,
shownin Figure 1.14.

Figure 1.14 Finishing aVisual Basic Application Wizard project.

Click Finishiin the last Application Wizard screen now to create the project, and run that project, as
shown in Figure 1.15.

Figure 1.15 Running our Visual Basic Application Wizard program.

This new program has a great deal of programming power. Asyou can see in Figure 1.15, this program is
an MDI program, capable of opening multiple documents and even displaying a Web browser in a
window. In fact, you can even use the File menu s Open, Save, and Save As items to open and display
files.

There salot of power here, and we |l see how to do all these things ourselvesin this book. It sinstructive
to take alook at the project file for this project, where we see that this project makes use of these ActiveX
controls:

" Common dialogs (COMDLG32.0CX)

" Common windows controls (COMCTL32.0CX)
" Richtext control (RICHTX32.0CX)

" Web browser DLL (SHDOCVW.DLL)

Here is the code snippet:

Type=Exe
Ref erence=*\ G 00020430- 0000- 0000- CO00- _
000000000046} #2. O#0#. . \ . . \ W NDOWS\ SYSTEM STDOLE2. TLB#OLE Aut onati on
Modul e=Modul el; Modul el. bas
For m=f r mvVRi n. f rm
(bj ect ={ FO043C88- F6F2- 101A- A3C9- 08002B2F49FB} #1. 2#0; COMDLG32. OCX
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Obj ect ={ 6B7E6392- 850A- 101B- AFCO- 4210102A8DA7} #1. 3#0; COMCTL32. OCX
For mef r nSpl ash. frm

(bj ect ={ 3B7C8863- D78F- 101B- B9B5- 04021C009402} #1. 1#0; RI CHTX32. OCX
For mef r mDocunent . frm

bj ect ={ EAB22AC0- 30C1- 11CF- A7EB- 0000CO5BAEOB} #1. 1#0; SHDOCVW DLL
FormefrmBrowser. frm
Startup="Sub Min"
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Note the last of the statements, Startup= Sub Main . Thisindicates that this program starts with aMain()
procedure, not a startup form (we |l see more about this in the next chapter). In the Main() procedure, the
program first loads the splash screen, then the MDI frame window. The MDI frame window in turn loads its
first child window, based on the frmDocument form. Taking alook at frmDocument.frm, which appearsin
Listing 1.3, indicates that this child window displays arich text control (as you can see by the inclusion of the
rich text control), which in fact handles all the text. Asyou can see, taking apart projects file by file this way
removes all the mystery, and it sa good skill for the Visual Basic programmer to have.

Listing 1.3 frmDocument.frm

VERSI ON 6. 00
Ooj ect = "{3B7C8863- D78F- 101B- B9B5- 04021C009402} #1. 1#0"; "Rl CHTX32. OCX"
Begi n VB. For m f r nrDocunent

Caption = "frnmDocunent "
C i ent Hei ght = 3195
ClientlLeft = 60
CientTop = 345
CientWdth = 4680
Li nkTopi ¢ = " For mL"
MDI Chi | d = -1 'True
Scal eHei ght = 3195
Scal eW dth = 4680
Begin Ri chTextLib. R chText Box rtf Text
Hei ght = 2000
Left = 100
Tabl ndex = 0
Top = 100
W dt h = 3000
_Extent X = 5292
_ExtentyY = 3519
_Version = 393216
Enabl ed = -1 'True
Scrol | Bars = 3
Ri ght Mar gi n = 8eb
Text RTF =  $"frnDocunent. frx": 0000
End
End

Attribute VB Nane = "frnDocunent™
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Attri bute VB d obal NaneSpace = Fal se
Attribute VB Creatable = Fal se
Attribute VB Predeclaredld = True
Attribute VB Exposed = Fal se

Private Sub rtfText Sel Change()

f Mai nForm t bTool Bar. Buttons("Bol d"). Value = I1f(rtfText. Sel Bol d,
t br Pressed, tbrUnpressed)
f Mai nForm t bTool Bar. Buttons("lItalic").Value = IIf(rtfText.Selltalic,

t br Pressed, tbrUnpressed)

f Mai nForm t bTool Bar. Butt ons(" Underline"). Value = _
I1f(rtfText. Sel Underline, tbrPressed, tbrUnpressed)

f Mai nForm t bTool Bar. Buttons("Align Left"). Value = _
I1f(rtfText.Sel Alignment = rtflLeft, tbrPressed, tbrUnpressed)

f Mai nForm t bTool Bar. Buttons("Align Right").Value = _
I1f(rtfText. Sel Alignment = rtfRight, tbrPressed, tbrUnpressed)

f Mai nForm t bTool Bar. Butt ons("Center"). Value = _
[1f(rtfText. Sel Alignment = rtfCenter, tbrPressed, tbrUnpressed)

End Sub

Private Sub Form Load()
For m Resi ze
End Sub

Private Sub Form Resi ze()
On Error Resune Next
rtfText. Move 100, 100, Me. Scal eWdth - 200, M. Scal eHei ght - 200
rtfText. Rrght Margin = rtfText. Wdth - 400

End Sub

That completes our overview of Visual Basic projects for now, although there will be more about projects
throughout the book. We Il turn to an overview of another kind now: discussing topics that impact every
chapter in the book. In this overview, we re going to cover general Visual Basic programming issues,
including Visual Basic conventions, best coding practices, and code optimization. This discussion touches
practically every aspect of our book, so it s best to consider it first.

Visual Basic Programming Conventions

Microsoft has set up a number of conventions for programming Visual Basic, including naming conventions.
These conventions are not necessary if you program alone, but they can still be helpful. If you program as part
of ateam, these conventions can be very valuable, because they provide cluesto avariable s scope and type to
someone reading your code. Because many Visua Basic programmers work in teams these days, we Il cover
the Microsoft programming conventions here, beginning with variable scope prefixes.
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Variable Scope Prefixes

You use avariable prefix in front of its name to indicate something about that variable. For example, if you
have a global variable named Error Count, you can use the g prefix to indicate that that variable is global this
way: gError Count. Microsoft has established scope prefixes for variables as shown in Table 1.3.

Table 1.3 Variable
scope prefix _
conventions. Scope Prefix

Global g
Module-level or
m
form-level

L ocal to procedure None

The scope prefixes come before all other prefixes and there are many other types, such as variable prefixes,
control prefixes, and so on. We Il continue with variable prefixes.

Variable Prefixes

Ideally, variable names should be prefixed to indicate their data type. Table 1.4 lists the prefixes that
Microsoft recommends for al the Visual Basic datatypes.

Table 1.4 Variable
prefixes. Data

Type Pr efix
Boolean bin
Byte byt
Collection object col
Currency cur
Date (Time) dtm
Double dbl
Error err
Integer int
Long Ing
Object obj
Single sng
String str
User-defined type udt
Variant vnt

Here are some prefixed variable names using the recommended variable prefixes:

bl nTrueFal se ' Bool ean
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i nt Count er "I nt eger
sngDi vi dend "Single

Using variable prefixes this way provides some clue as to the variable s type, and that can be extraordinarily
helpful if someone else will be reading your code. Note that it s also a good ideato prefix function names
using the above prefixes to indicate the return type of the function.

Besides variable prefixes, Microsoft also has a set of prefixes for the standard control types.
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Control Prefixes

The suggested Microsoft control prefixes appear in Table 1.5. Asyou can see, there s
asuggested prefix for every standard type of control.

Table 1.5 Control
prefixes. Control

Type Prefix
3D pand pnl
ADO data ado
Animated button ani
Checkbox chk
Combo box, bo
drop-down list box
Command button cmd
Common diaog dig
Communications com
Control (used within ctr
procedures when the
specific typeis
unknown)
Data dat
Datarbokl)md combo dbcbo
OX
Data-bound grid dbgrd
Data-bound list box dblst
Data combo dbc
Datagrid dgd
Datalist dbl
Data repeater drp
Date picker dtp
Directory list box dir
Drive list box drv
File list box fil
Flat scroll bar fsb
Form frm
Frame fra
Gauge gau
Graph gra
Grid grd
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Header hdr
Hierarchical flex grid flex
Horizontal scroll bar hsb

Image img

Image combo imgcbo
Image list ils
Label Ibl
Lightweight checkbox lwchk
Li ghtwekl) ght combo lwebo
OX
Lightweight
comr%and b%tton wemd
Lightweight frame lwfra
Lightweight
horizo%tal sc?oll bar whsb
Lightweight list box Iwist
Lightweight option
’ butgton i Iwopt
Lightweight text box lwixt
Lightweight vertical IWvsh
scroll bar
Line lin
List box st
List view [vw
MAPI message mpm
MAPI session mps
MCI mci
Menu mnu
Month view mvw
MS chart ch
MSflex grid msg
MS tab mst
OLE container ole
Option button opt
Picture box pic
Pictureclip clp
Progress bar prg
Remote data rd
Rich text box rtf
Shape shp
Slider dd
Spin spn
Status bar sta
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System info sys
Tab strip tab
Text box txt

Timer tmr
Toolbar tlb
Treeview tre
Up-down upd

Vertica scroll bar vsb

If you work with databases, take alook at Table 1.6, which holds the prefixes for Data
Access Objects (DAO).

Table 1.6 Data
Access Object
prefixes.
Database Prefix
Object
Container con
Database db
DBEnNgine dbe
Document doc
Field fld
Group arp
I ndex IX
Parameter prm
QueryDef gry
Recordset rec
Relation rel
TableDef tbd
User usr

Workspace wsp

Besides the prefixesin Table 1.6, Microsoft recommends prefixes for menus and
constants as well, and we |l take alook at these now to round off our discussion on
this topic.

Menu And Constant Prefixes

Microsoft recommends that you prefix menu controls with mnu and then the menu
name followed by the menu item name. For example, the File menu s Open item
would be named mnuFileOpen, and the Edit menu s Cut item would be named
mnuEditCut. Microsoft also recommends that constant names (you declare constants
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with the Const statement) should be mixed case with capitals starting each word, for
example:

Const Di skDriveNumber =1 " Const ant
Const WMaxi munFi | eCount = 1024 " Const ant

TIP: Although standard Visual Basic constants do not include data type and scope
information, prefixeslikei, s, g, and m can be useful in understanding the value or
scope of a constant.

That completes the prefix and naming conventions. As you can see, there are prefixes
for just about every type of programming construct available. Y ou re not constrained
to use them, but if you work in ateam, they can be extremely helpful.

Microsoft also has a set of suggestions on commenting your code, and we |l take a
look at those suggestions now.

Code Commenting Conventions

In general, you should add a new comment when you declare a new and important
variable, or wish to make clear some implementation method. Ideally, procedures
should only have one purpose and be named clearly enough so that excessive
comments are not required. In addition, procedures should begin with a comment
describing what the procedure does, and that comment should be broken up into
various sections. The Microsoft recommendations for those sections appear in Table
1.7; note that not all sections may be applicable for al procedures.

Table 1.7
Procedures
for starting
comment
block
sections.
Section
Heading

Comment Description

Purpose What the procedure does
Assumptions List of each external variable, control, open file, or other element that is
not obvious
Effects List of each affected external variable, control, or file and the effect it
has (only if thisis not obvious)
Inputs Each argument that may not be obvious,; arguments are on a separate
line with inline comments
Returns  Explanation of the values returned by functions
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Here s an example showing how to set up a comment preceding a function named dblSquar &():

LI S R S Sk b S b S b S S S b b i I b R b S S S S R S S b S

dbl Squar e()
Pur pose: Squares a nunber
| nputs: sngSquareMe, the value to be squared
Returns: The input val ue squared
LS SRR b b b b I b b b e b b B b I b b b S b S B R b b b I b b b I S I Sk A I b
Function dbl Square() (sngSquareMe As |Integer) As Double
dbl Square = sngSquareMe * sngSquar eMe ‘Use *, not "2, for speed
End Function

TIP: You might notice that dblSquar &) takes a Single parameter and returns a Double value; that s
because squaring a Single can create a larger number, which might not fit into a Single value, or it can
add more decimal places. Note also that we multiply the parameter sngSquareM e by itself to square it
instead of using the exponentiation operator, because doing so saves alot of processor time.

Note that it s particularly important to list all the global variables a procedure uses or affectsin this
initial comment block, because they are not listed in the parameter list.

That completes our overview of the Visual Basic programming conventions. We Il finish the chapter
with alook at what we might call best coding practices, astargeted at Visual Basic. Through the years,
some definite programming practices have proven themselves better than others, and we Il take alook at
some of them now before digging into the rest of the book.

Best Coding Practices In Visual Basic

The full construction of acommercial program is usually a project that involves many clear and definite
steps. There have been whole volumes written on this topic, which are usually only interesting if you are
a software project manager (or write computer books and have to know the details so you can write
about them!). Such books get pretty involved, encompassing ideas like module coupling and cohesion,
bottom-up composition, incremental integration, and much more.

On the whole, however, one can break the software design process into steps like these (note that the
explanation of each step is very flexible; there is no one-size-fits-all here):

" Requirements analysis Identify the problem for the software to tackle.
" Creating specifications Determine what exactly the software should do.

" Overall design Break the overall project into parts, modules, and so on.
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' Detailed design Design the actual data structures, procedures, and so on .
" Coding Go from PDL to code.

" Debugging Solve design-time, compilation, and obvious errors.

' Testing Try to break the software.

" Maintenance React to user feedback and keep testing.

Each of these steps may have many subparts, of course. (For example, the maintenance part may take up
as much time as the rest of the project taken together.)

As the design process continues, amodel of what the program does evolves. Y ou use this model to get a
conceptual handle on the software (while keeping in mind that models are usually flawed at some level).
Keeping the model in mind, then, many programmers use a program design language to start the actual
coding process.

Program Design Language

Everyone seemsto think that programmers use flowcharts, but the reality isusualy different (flowcharts
are nice to show to nonprogrammers, though). One tool that commercia programmers do find useful is
program design language (PDL). Although there are formal specifications for PDL, many programmers
simply regard this step as writing out what a program does in English as a sort of pseudo-code.

For example, if we want to create a new function named dblSqgrt() that returns a number s square root,
we might write its PDL thisway in English, where we break what the function does into steps:

Function dbl Sgrt ()
Check if the input paraneter is negative
If the input paraneter is negative, return -1
| f the input paraneter is positive, return its square root
End Function

When you actually write the code, the PDL can often become the comments in that code; for example,
here s the completed function:

LIS SRR R Sk Sk S b b b S b b S b b b b b b b b S b b b b S S b S S S S S S b b b S S S Sk b b b b b b b S

" dbl Sgrt ()

Pur pose: Returns the passed paraneter's square root

| nputs: dbl Paraneter, the paraneter whose square root we need
Returns: The input value's square root

LI SRR Sk S b b b b S b b S b b b b b b b b I S B b b b b b I B b b b S S SR B b b b b b b b b b

Function dbl Sgrt (dbl Paraneter As Doubl e) As Doubl e
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‘Check if the input paraneter is negative
| f dbl Paranmeter < 0 Then
"If the input paraneter is negative, return -1
dbl Sgrt = -1

El se
"If the input paraneter is positive, return its square root

dbl Sgrt = Sqr (dbl Par anet er)

End |f
End Functi on

In thisway, developing your program using PDL, where every line of PDL has one (and only one)
specific task, can be very useful. So much for overview let sturn to particulars that affect us as Visual

Basic programmers.
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Coding To Get The Most From Visual Basic

In this section, we Il discuss some best practices coding for Visual Basic. All of these
practices come from professional programmers, but of course whether you implement
them or not is up to you. Here we go:

" Avoid magic numbers when you can. A magic number is anumber (excluding O or
1) that s hardwired right into your code like this:

Functi on bl nCheckSi ze(dbl Paraneter As Doubl e) As Bool ean

| f dbl Paraneter > 1024 Then
bl nCheckSi ze = True

El se
bl nCheckSi ze = Fal se

End |f
End Functi on

Here, 1024 is amagic number. It s better to declare such numbers as constants,
especialy if you have a number of them. When it stime to change your code, you just
have to change the constant declaration in one place, not try to find all the magic
numbers scattered around your code.

" Be modular. Putting code and data together into modules hides it from the rest of the
program, makesit easier to debug, makesit easier to work with conceptually, and even
makes |oad-time of proceduresin the same module quicker. Being modular also called
information-hiding (and encapsulation in true OOP) is the backbone of working with
larger programs. Divide and conquer is the idea here.

" Program defensively. An example of programming defensively would be to check
data passed to you in a procedure before using it. This can save a bug from propagating
throughout your program and help pinpoint its source. Make no assumptions.

" Visual Basic procedures should have only one purpose, ideally. Thisisalso anaid in
larger programs when things start to get complex. Certainly if a procedure has two
distinct tasks, consider breaking it up.

" Avoid deep nesting of conditionals or loops. Debugging deeply nested conditionals
visually isvery, very inefficient. If you need to, place some of the inner loops or
conditionalsin new procedures and call them. Three levels of nesting should be about
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the maximum.

" Use access procedures to protect sensitive data. (Thisis part of programming
defensively.) Access procedures are also called Get/Set procedures, and they are called
by the rest of the program when you want to work with sensitive data. If the rest of the
program must call a Set() procedure to set that data, you can test to make sure that the
new value is acceptable, providing a screen between that data and the rest of the
program.

' Ideally, variables should always be defined with the smallest scope possible. Global
variables can create enormously complex conditions. (In fact, Microsoft recommends
that global variables should be used only when there is no other convenient way to
share data between forms.)

" Do not pass global variablesto procedures. If you pass global variablesto
procedures, the procedure you pass that variable to might give it one name (as a passed
parameter) and also reference it asaglobal variable. This can lead to some serious bugs,
because now the procedure has two different names for the variable.

" Usethe & operator when linking strings and the + operator when working with
numerical values. Thisis per Microsoft s recommendations.

When you create a long string, use the under score line-continuation character to
create multiple lines of code. Thisis so you can read or debug the string easily. For
example:

Dm Msg As String

Msg = "Well, there is a problem"
&' W th your program | amnot sure
& what the problemis, but thereis " _
&'definitely sonething wong."

" Avoid using variants if you can. Although convenient, they waste not only memory
but time. Y ou may be surprised by this. Remember, however, that Visual Basic has to
convert the datain a variant to the proper type when it learns what is required, and that
conversion actually takes a great deal of time.

" Indent your code with four spaces per Microsoft s recommendations. Believe it or
not, there have been serious studies undertaken here, and 2 to 4 spaces were found to be
best. Be consistent.

" Finally, watch out for one big Visual Basic pitfall: misspelled variables. Because you
dont haveto declare avariable in Visual Basic to useit, you might end up surprised
when Visual Basic creates a new variable after you ve misspelled avariable s name. For
example, here s some perfectly legal code modified from our tic-tac-toe project that
compiles and runs, but because of a misspelling xNoww for xNow it doesn t work at all:
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Private Sub Command_Cick(Ilndex As I|nteger)

| f xNow Then

Command( | ndex) . Caption = "x"
El se

Command( | ndex) . Caption = "o"
End If

xNoww = Not XxNow
End Sub

Because Visual Basic treats xXNoww as alegal variable, thiskind of bug is very hard to
find when debugging.

TIP: Because Visua Basic auto-declares variables, it s usually better to use variable
names that say something (like intCurrentlndex) instead of onesthat dont (like
iIntDD35A) to avoid declaring a variable through misspelling its name. A better ideais
to use Option Explicit to make sure al variables must be explicitly declared.

If you work in teams, use version control. There are several well-known utilities that
help programmers work in teams, such as Microsoft s Visual SourceSafe. This utility,
which is designed to work with programming environments like Visual Basic, restricts
access to code so that two programmers don t end up modifying independent copies of
the samefile.

That sit for our best practices tips for now. We Il see more throughout the book.
Getting Down To The Details

That completes our overview of topics common to the rest of the book. In this chapter,
we ve seen an overview of aVisual Basic project, including what goes into a project,
how it s stored on disk, and how the idea of scope worksin a project. We ve also seen a
number of Visual Basic programming considerations, from naming conventions to best
programming practices, including alist of Visual Basic-specific topics.

We reready for the rest of the book, and we Il turn to the first natural topic now the
Visual Basic IDE.
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Chapter 2
The Visual Basic Development
Environment

If you need an immediate solution to:

Selecting IDE Colors, Fonts, And Font Sizes

Aligning, Sizing, And Spacing Multiple Controls

Setting A Startup Form Or Procedure

Using Visual Basic Predefined Forms, Menus, And Projects
Setting A Project sVersion Information

Setting An EXE File sName And Icon

Displaying The Debug, Edit, And Form Editor Toolbars
Turning Bounds Checking On Or Off

Checking For Pentium Errors

Managing Add-Ins

Adding ActiveX Controls And Insertable Objects To Projects
Customizing Menus And Toolbars

Setting Forms Initial Positions

Enabling Or Disabling Quick Info, Auto List Members, Data Tips, And Syntax
Checking

Displaying Or Hiding IDE Windows

Searching An Entire Project For Specific Text Or A Variable s Definition
Optimizing For Fast Code, Small Code, Or A Particular Processor
Adding And Removing Forms, Modules, And Class Modules

Using Bookmarks

Using The Object Browser
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In Depth

In this chapter, we re going to get started with Visual Basic at the logical place to
start: the Visual Basic Integrated Development Environment (IDE). The IDE is
where you do your programming work in Visual Basic just as the name says, you
develop your projects in the Integrated Development Environment.

Over the years, the IDE has become more powerful, and with that power has come
complexity. The IDE used to be more or less invisible to the programmer, but now
that there are all kinds of project options, ActiveX controls to add, version resource
data to set, and so much more, the IDE has become a worthy object of study. In this
chapter, we Il cover IDE tasks so you don t have to dig out that information when
you have more important things to do. Well start with an overview of the IDE, and
then go directly to the Practical Guide for the IDE, showing how to get things done.

Overview Of The Integrated Development Environment

The Visual Basic IDE appearsin Figure 2.1, and as aVisual Basic programmer, this
iswhere you Il spend most of your programming time. If you re not already familiar
with the parts of the IDE, you will bein time.

Figure 2.1 TheVisua Basic Integrated Devel opment Environment.

The Visual Basic IDE has three distinct states. Design, Run, and Debug. The
current state appearsin Visua Basic stitle bar. This chapter concentrates on the
Design state. We Il cover the Debug state later in the book. (In the Run state, Visual
Basic isin the background while your program runs.) It sthe Design state that s
become complex over the years, and wel ll lay it bare in this chapter.

The IDE is composed of these parts:
' The menu bar

" The toolbar

" The Project Explorer

' The Properties window

" The Form Layout window

" The toolbox

" Form designers

Code windows

Well takealook at all of these partsin this overview.
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The Menu Bar

The menu bar presents the Visual Basic menus. Here salist of those menus and
what they do:

" File File handling and printing; also used to make EXE files
" Edit Standard editing functions, undo, searches
" View Displays or hides windows and toolbars

" Project Sets project properties, adds/removes forms and modules, and
adds/removes references and components

" Format Aligns or sizes controls
" Debug Starts/stops debugging and stepping through programs

' Run Starts a program, or compiles and starts it

Tools Adds procedures, starts the Menu Editor, sets IDE options

" Add-Ins Add-in manager, lists add-ins like Application Wizard and APl Viewer
" Window Arranges or selects open windows

" Help Handles Help and the About box

TIP: Note that one important job of the File menu isto create EXE files for your
program. When you run a program from the Run menu, no EXE fileis created,; if
you want to run the program outside of Visual Basic, you must create that EXE file,
and you do that with the File menu s Make ProjectName.exe item (where
ProjectName is the name you ve set for the project).

Welll see agreat dea more about these menus and the items they contain in the
Immediate Solutions section of this chapter.

The Toolbar

The main Visual Basic toolbar appearsin Figure 2.2. Thistoolbar contains buttons
matching popular menu items, as you can see in Figure 2.2; clicking the button is
the same as selecting a menu item and can save you some time.

Figure 2.2 Themain Visual Basic toolbar.

Besides the main toolbar, you can also display other dockable toolbarsin Visual
Basic: the Debug, Edit, and Form Editor toolbars. To display one of these toolbars,
just select it using the Toolbars item in the View menu; the toolbar appears
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free-floating at first, but you can dock it asyou likein the IDE.

TIP: If you re unsure what a particular tool in the toolbar does, just rest the mouse

over it. A tool tip (asmall yellow window displaying text) will display the tool s
purpose.
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Form Designers And Code Windows

The last parts of the IDE that we || take alook at in our overview are form designers
and code windows, which appear in the center of Figure 2.8. (The form designer
displays the current form under design, complete with command button, and the
code window displays the code for the Command1_Click() procedure.)

Figure 2.8 A form designer and code window.

Form designers are really just windows in which a particular form appears. Y ou can
place controlsinto aform ssimply by drawing them after clicking the corresponding
control stool in the toolbox.

Code windows are similarly easy to understand: you just place the code you want to
attach to an object in the code window (to open an object s code in the code
window, just double-click that object). There are two drop-down list boxes at the
top of the code window: the left list lets you select the object to add code to, and the
right list lets you select the procedure to add (all the methods the object supports
appear in thislist).

That completes our overview of the IDE. Let s get into the actual meat of the
chapter now, task by task.

Immediate Solutions
Selecting IDE Colors, Fonts, And Font Sizes

The Visual Basic IDE comes with all kinds of preset colors blue for keywords,
green for comments, black for other code, and so on. But as when you move into a
new house, you might want to do your own decorating. Visual Basic allows you to
do that. Just open the Options box by clicking the Optionsitem in the Visual Basic
Tools menu, and click the Editor Format tab, as shown in Figure 2.9.

Figure 2.9 Selecting IDE colors.

Here are the text items whose colors you can select:
" Normal Text

" Selection Text

" Syntax Error Text
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" Execution Point Text
" Breakpoint Text
Comment Text
' Keyword Text
|dentifier Text
Bookmark Text
' Call Return Text

To set aparticular type of text s color and background color, just select the
appropriate color from the drop-down list boxes labeled Foreground and
Background, and click on OK. Y ou can also set text font and font sizes in the same
way just specify the new setting and click on the OK button to customize the text
the way you want it.

Aligning, Sizing, And Spacing Multiple Controls

Visual Basicisvery...well...visual, and that includes the layout of controlsin your
programs. If you ve got a number of controls that should be aligned in a straight
ling, it can be murder to have to squint at the screen, aligning those controlsin aline
down to the very last pixel. Fortunately, there s an easier way to do it:

1. Hold down the Ctrl key and click all the controls you want to align.
2. Make sure you have one control in the correct position, and click that one last.

Szing handles, the eight small boxes that you can grasp with the mouse to resize a
control, appear around all the clicked controls. The sizing handles appear hollow
around al but the last control you clicked, as shown in Figure 2.10; the last control
you clicked has solid sizing handles, and it will act as the key control. The other
controls will be aligned using this key control s position.

To align all the selected controls to the same left, right, or center position of the key
control, you continue with these steps:

3. Select the Align item in the Format menu, opening the Align submenu, as shown
in Figure 2.10.

Figure 2.10 Aligning new controls.

4. Select the type of alignment you want in the Align submenu: align the left, the
center, the right, the top, the middle, or the bottom edges of the controls with the
key control.
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5. While the controls are still collectively selected, you can move them, if you like,
as agroup to any new location now that they are aligned as you want them.

To size all selected controls the same as the key control, follow Steps 1 and 2, and
then continue this way:

3. Select the Make Same Size item in the Format menu, opening that submenu, as
shown in Figure 2.11.

Figure 2.11 Sizing new controls.

4. Choose the appropriate item in the Make Same Size submenu to size the controls
as you want them: matching the key control swidth, height, or both.

To space multiple controls vertically or horizontally, follow Steps 1 and 2 and then
continue;

3. Select the Horizontal Spacing or Vertical Spacing item in the Format menu,
opening that submenu, as shown in Figure 2.12.

Figure 2.12 Spacing controls.

4. To space the controls horizontally or vertically, select one of the itemsin the
corresponding submenu:

' Make Equal Sets the spacing to the average of the current spacing
" Increase Increases by one grid line

" Decrease Decreases by one grid line

' Remove Removes spacing

The Design Time Grid

Spacing depends on grid lines. The grid is made up of the array of dots you seeon a
form at design time. This grid isto help you place controls on aform, and by
default, controls are aligned to the grid (which means they are sized to fit along
vertical and horizontal lines of dots). Y ou can change the grid units (in twips) in the
Options box when you click the General tab, as shown in Figure 2.13. (To open the
Options box, select the Optionsitem in the Tools menu.)

Figure 2.13 Modifying the grid settings.

Besides setting the units of the grid, you can also specify whether or not controls
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must be aligned to the grid by checking the Align Controls To Grid checkbox.

Setting A Startup Form Or Procedure

Visual Basic programs mean windows, right? Not necessarily. Visual Basic
programs do not need to have any windows at all, in fact. That caseisalittle
extreme, but there are times when you don t want to start your program with codein
aform. For example, you might want to display a flash screen when your program
first starts, without waiting for the first (possibly complex) form to load, and then
switch to the form when it does load.
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Creating A Form-Free Startup Procedure

To start a program from code not in any form, you add a subroutine named M ain()
to your program. Follow these steps:

1. Select the Properties item in the Project menu to open the Project Properties box,
as shown in Figure 2.14.

Figure 2.14 The Project Properties box.

2. Click the General tab in the Project Properties box (if it s not already selected),
select Sub Main in the Startup Object drop-down list, and click on OK.

3. Select Add Module in the Project menu, and double-click the Module icon in the
Add Module box that opens.

4. Add this code to the new module s (General) section in the code window:

Sub Mai n()
End Sub

5. Place the code you want in the Main() subroutine.
Selecting The Startup Form

On the other hand, you might have a number of formsin a project how do you
specify which oneis displayed first? Y ou do that with the General tab of the Project
Properties box, just as we ve added a M ain() subroutine to our program.

To specify the startup form for a project, just open the Project Properties box as we
ve done in the previous section and select the appropriate form in the Startup
Object box, as shown in Figure 2.15. Now when your program starts, that form will
act asthe startup form.

Figure 2.15 Setting a project s startup form.

Using Visual Basic Predefined Forms, Menus, And Projects

Y ou re designing a new program, and you want a form with a complete File menu
onit. You dont want to use the Application Wizard, because that add-in would
redesign your whole project for you. Rather than designing a complete standard File
menu from scratch, there s an easier way: you can use one of the predefined menus
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that come with Visual Basic.
To add one of the predefined Visual Basic menus, follow these steps:
1. Select the form you want to add the menu to by clicking it with the mouse.

2. Open the Visual Component Manager from the Tools menu. If the Visual
Component Manager is not already loaded into Visual Basic, open the Add-In
Manager in the Add-Ins menu, click the box labeled Visual Component Manager,
and close the Add-In Manager. If your version of Visual Basic does not come with
the Visual Component Manager, refer to the discussion after these steps.

3. Open the Visual Basic folder in the Visual Component Manager.
4. Openthe Templates folder in the Visual Basic folder.
5. Open the Menus folder in the Templates folder, as shown in Figure 2.16.

Figure 2.16 Opening the Menus folder in the Visual Component Manager.

6. Select the type of menu you want and double-click it. These are the available
menus:

' Edit menu

" Filemenu

" Help menu

" View menu

" Window menu

7. The new menu will be added to the form you selected, as shown in Figure 2.17.

Figure 2.17 Adding a predefined Visual Basic menu to aform.

Besides menus, you can add a whole selection of predefined formsto your projects
by finding the Forms folder in the Templates folder in the Visual Component
Manager. Here are the available forms, ready to be added to your project with a
click of the mouse:

" Blank forms
" About dialog boxes (two types)
" Addinforms

" Browser forms
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Datagrid forms
Diaog forms

" Tipforms

Log-in forms

" ODBClog-informs
' Options forms

Query forms

Asyou Il seein the Visua Component Manager s Templates folder, you can add the
following pre-defined elementsto a Visual Basis Project:

" Classes

' Code procedures
" Control sets
Forms

" MDI forms
Menus

Modules

' Project templates
Property pages
User controls

" User documents

After you ve created components like these in Visual Basic, you can add them to
other projects using the Visual Component Manager in fact, reusing components
like thisis one of the things professional programmers and programming teams do
best.

If You Don t Have The Visual Component Manager

If your version of Visual Basic does not come with the Visual Component Manager,
you can still add many predefined components to a project, including forms, MDI
forms, modules, class modules, user controls, and property pages. For example, to
add a predefined form to your project, just select Add Form from the Project menu,
opening the Add Form dialog box, as shown in Figure 2.18.
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Figure 2.18 The Add Form dialog box.

Asyou can see, the predefined forms are here, so you can add them to your project
with asimple click of the mouse.

Adding menusis alittle different here, because you actually add a whole new form
with that menu, instead of adding that menu to an already-existing form. For
example, to add anew form with a File menu already in place, click the Existing tab
in the Add Form dialog box, click the Menus folder, and double-click the
Filemenu.frm entry. This adds a new form to your project, complete with File menu.
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Setting A Project s Version Information

Five years from now, a user stumbles across your EXE file, which you ve
conveniently named CDU2000.exe. This makes perfect sense to you what else
would you name the EXE file for a utility named Crop Dusting Utility 20007?
However, the user is alittle puzzled. How can he get more information directly
from the EXE file to know just what CDU2000.exe does? He can do that by
interrogating the file s version information.

A program s version information includes more than just the version number of the
program; it also can include the name of the company that makes the software,
general commentsto the user, legal copyrights, legal trademarks, the product name,
and the product description. All these items are available to the user, and if you re
releasing your software commercialy, you should fill these itemsin. Here s how
you do it:

1. Open the Project Properties box in Visual Basic now by selecting the Properties
item in the Project menu.

2. Select the Make tab, as shown in Figure 2.19.

Figure 2.19 Setting a project s version information.

3. Fill in the information you want, including the program s version number,
product name, and so on.

4. Create the EXE file, which in our case is CDU2000.exe, using the Make
CDU2000.exe item in the File menu.

5. Tolook at the version information in CDU2000.exe, find that file in the
Windows Explorer and right-click the file, selecting Properties from the pop-up
menu that opens. Asyou can seein Figure 2.20, our version information including
the name of the product appears in the Properties box.

Figure 2.20 Reading a program s version information.

Sometimes, version information is all that users have to go on when they encounter
your program, so be sure to include it before releasing that product.

Setting An EXE File s Name And Icon

Y ou re about to release your software commercially, but you suddenly realize that
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Project1.exe might not be the best name for your product s executable file. The
stockholders meeting isin five minutes how can you change your EXE file s name?

To set the EXE file s name, you just set the project s name. Here s how you do it:

1. Select the Properties item in the Project menu to open the Project Properties box,
asshown in Figure 2.21.

Figure 2.21 Setting a project s name.
2. Select the General tab in the Project Properties box (if it s not already selected).

3. Enter the name of the project you want to use, such as CDU2000 in Figure 2.21.

4. The project s name will become the name of the EXE file when you create it
with the Make CDU2000.exe item in the File menu.

Now you ve named your EXE file, but how do you set the program sicon that will
appear in Windows? The program sicon isjust the icon of the startup form, and you
can set that by setting that form s Icon property in the Properties window. If you
have anew icon in ICO file format, you can load that icon right into that form by
setting the form s | con property to the ICO file name.

Displaying The Debug, Edit, And Form Editor Toolbars

By default, Visual Basic displays one toolbar, the standard toolbar. However, there
are other toolbars available the Debug, Edit, and Form Editor toolbars. If you want
them, you add those toolbars with the Toolbars submenu of the Visual Basic View
menu just click the new toolbar you want to add. Y ou can also remove one or all
toolbars the same way.

The Debug toolbar has the following buttons:
' Start

" Break

" End

' Toggle Breakpoint

Step Into

Step Over

' Step Out

" Locals Window

" Immediate Window
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" Watch Window

" Quick Watch

" Cadl Stack

The Edit toolbar includes these buttons:
' List PropertiessMethods
" List Constants

" Quick Info

' Parameter Info

" Complete Word

| ndent

' Outdent

Toggle Breakpoint
Comment Block

' Uncomment Block
Toggle Bookmark

Next Bookmark

' Previous Bookmark

" Clear All Bookmarks

The Form Editor toolbar includes these buttons:
" Bring To Front

" Send To Back

Align

' Center

" Width

Lock Controls

The Debug, Edit, and Form Editor toolbars appear from left to right in the top
toolbar in Figure 2.22.
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Figure 2.22 Visua Basic with the Debug, Edit, and Form toolbars.
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Turning Bounds Checking On Or Off

When you use arrays, Visual Basic checks to make sure that you don t inadvertently
try to access memory past the end or before the beginning of the array when the
program runs, which is an error that could corrupt memory. In the early days of
programming, however, you could use array index values that were past the end of
an array without causing a compiler error, and some programmers used to rely on
that to create some programming tricks involving accessing memory far beyond
what they were supposed to stick with (especially in C, where the name of an array
isreally apointer). That practice is heavily discouraged today, but some
programmers must still have a soft spot for it, because Visual Basic alows you to
turn off array bounds checking. (In fairness, there are one or two other reasons you
might want to turn off bounds checking, such as not having the program halt for
bounds violations while you re trying to track down a bug or, conceivably, for
performance reasons.)

What does a bounds violation look like? Here s an example in code where we set up
an array and then try to access alocation past the end of it:

Private Sub Commandl O i ck()
Dim Addresses(1 To 10) As Integer

Addresses(1) =1 "Fi ne
Addresses(11) = 11 " Probl em
End Sub

If you were to run this code, you d get the error box shown in Figure 2.23 unless
you turn off bounds checking.

Figure 2.23 An out-of-bounds error.

Y ou can turn off bounds checking by following these steps:
1. Select the Properties item in the Project menu to open the Project Properties box.
2. Select the Compile tab in the Project Properties window.

3. Click the Advanced Optimizations button in the Project Properties window to
open the Advanced Optimizations box, as shown in Figure 2.24.

Figure 2.24 Turning off bounds checking.
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4. Select the Remove Array Bounds Checks checkbox to turn off array bounds
checking.

That sit now you ve turned off array bounds checking.

WARNING! Before turning off array bounds checking, however, make sure you
have areally good reason for doing so; you may find your program crashing
Windows as it makesillegal use of memory.

Checking For Pentium Errors

Some time ago, one version of the Intel Pentium suffered from a well-publicized
hardware bug in the floating point instruction named FDIV. Intel responded quickly
and offered to replace the defective chips, but it s reasonable to expect some are still
out there.

For that reason, Visual Basic has a check to make sure the Pentium your program
runs on is safe. That check is enabled by default, but if for some reason you want to
turn it off (although it is hard to see why you would), you can turn off the Pentium
FDIV check with these steps:

1. Select the Propertiesitem in the Project menu to open the Project Properties box.
2. Select the Compile tab in the Project Properties window.

3. Click the Advanced Optimizations button in the Project Properties window to
open the Advanced Optimizations box (as shown earlier in Figure 2.24).

4. Select the Remove Safe Pentium FDIV Checks checkbox.

That sit you ve disabled the FDIV Pentium check. Although you might want to do
thisyourself if you know what you re doing, it s not recommended that you do this
in any software you release commercially.

Managing Add-Ins

The deadline for your project is fast approaching, and the pressure is on. Suddenly it
occursto you that you ve already written alot of the components you need to use
the day is saved! But how can you access those components? One easy way isto
use the Visual Component Manager. But when you check the Visual Basic Add-Ins
menu, you don t see the Visual Component Manager there. How do you add it?

Y ou use the Visual Basic Add-In Manager to add this and any other add-in. Here s
how to use the Add-In Manager:

1. Select the Add-In Manager item in the Visual Basic Add-In menu.
2. The Add-In Manager opens, as shown in Figure 2.25.
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Figure 2.25 The Visual Basic Add-In Manager.

3. Select the add-ins you want, as also shown in Figure 2.25, and close the Add-In
Manager.

That sit now you ve added the add-in you want. To remove it, ssimply deselect the
add-in s box in the Add-In Manager. (Some add-ins have an annoying habit of
starting when Visual Basic starts, grinding on for along time while it loads and
taking up alot of memory, which can be annoying if you don t need the add-in any
more.)

Adding ActiveX Controls And Insertable Objects To Projects

Been away from Visual Basic for awhile and need to get back into the swing of
things? Y ou ve been designing your project but suddenly realize you need a
Microsoft Grid control. That san ActiveX control how do you add those again? Use
the Add File To Project menu item? Double-click the toolbox and hope an Insert
dialog box comes up? Add areference to the actual Grid control s OCX file,
asctrls.ocx, to the project?

None of those here s how you do it:
1. Select the Project menu s Components item.

2. The Visua Basic Components box opens, as shown in Figure 2.26; click the
Controlstab in the Components dialog box.

Figure 2.26 The Visual Basic Components dialog box.

3. Select the ActiveX control you want to add in the Components box, then close
the Components box. The new control will appear in the toolbox.

TIP: If the ActiveX control you want to add to aVisual Basic project doesn t
appear in the Components dialog box, it may not have been registered with
Windows properly. Try using the regsvr32.exe tool in the Windows\system
directory to register it again.

Y ou can also add insertable objects like Microsoft Word or Microsoft Excel objects
to aVisual Basic project by using the Components dialog box. Instead of the
Controlstab in the Components box, however, you use the Insertable Objects tab
and select the object you want; that object will appear in the toolbox, and you can
use it in your project from then on. For example, we ve inserted an Excel worksheet
into the Visual Basic project in Figure 2.27.
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Figure 2.27 A Microsoft Excel worksheet in aVisual Basic project.
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Customizing Menus And Toolbars

Visual Basic might be nice, but it sjust not set up asyou d likeit. Y ou might think,
for example, that the Start menu item to run programs surely should be in the Edit
menu. Well, if you d like to place it there, it s possible (just don t expect anyone else
to be able to use Visual Basic after you ve customized it that way...).

Here s how you move items between menus or toolbars:
1. Right-click the menu bar to open the Customize box.

2. Next, find the menu item you want to add to another menu or to atoolbar; here,
we Il move the Start menu item to the Edit menu.

3. Using the mouse, drag the menu item from the Customize dialog s Command
box to the new location in amenu or atoolbar, as shown in Figure 2.28, where we
drag the Start item to the Edit menu.

Figure 2.28 Add the Start menu item to the Visual Basic Edit menu.

4. Releasing the mouse adds the menu item to its new location. Finally, click Close
in the Customize box to close that dialog.

Besides moving menu items to new locations in menus and toolbars, you can also
move whole menus. For example, to move the Edit menu in the menu bar, just open
the Customize box and find the Built-in Menus item in the Categories box of the
Commands tab. Next, drag the menu you want to move such as the Edit menu from
the Commands box to its new location in the menu bar. Y ou can move menus to
either the menu bar or other toolbars this way.

TIP: If you use one particular menu item alot, you might consider moving it
directly into the menu bar (whereit will appear among all the menu names). Y ou
can do that the same way you d drag that item to anew menu just drag it into the
menu bar instead.

Thetoolbarsin Visual Basic are dockable, of course, so that means you can move
them around as you d like even above the menu bar. Just grasp the double upright
bars at |eft in the toolbar (Visua Basic uses Explorer-style toolbars) and move the
toolbar to its new location.

Setting Forms Initial Positions

Y ou ve completed the project on schedule and under budget even. But you re not
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crazy about where Visual Basic displays the startup form on the screen when the
program starts. Y ou can set the form s Left and Top properties if you like, but there
s an easier and more interactive way using the Form Layout window.

The Form Layout window is part of the IDE, and its default position is at the lower
right in the IDE. Thiswindow appearsin Figure 2.29.

Figure 2.29 Setting aform sinitial position.

Setting aform sinitial position couldn t be easier just drag the form into the new
location using the mouse. If you want to know the form s exact new position, watch
the first set of numbersin the toolbar those numbers record the location of the upper
left of the form (in twips).

TIP: Using the Form Layout window, you can even place forms off screen, beyond
the edges of the display. That means, of course, that if you want to see the form
when the program runs, you Il have to moveit, either by setting its Left and Top
properties or with the Move method.

Enabling Or Disabling Quick Info, Auto List Members, Data Tips, And
Syntax Checking

Depending on your personal tastes, Visual Basic has a great/terrible set of
features/bugs that assist/hobble you while working on your code. These features are
asfollows:

" Quick Info

" Auto List Members
" DataTips

" Syntax Checking

The Quick Info feature lets you know what parameters a procedure takes as you re
actually typing the procedure sname, asin Figure 2.30. Thisis a useful feature that
can save you time looking up parameter order or type.

Figure 2.30 The Visual Basic Quick Info feature.

The Auto List Members feature lists the members of an object as you re typing the
object s name (actually when you type the dot [.] after the object sname, asin
Figure 2.31). Thisis useful if you can t remember exactly what property you want
to work with (for example, do | want the Text property, or wasit the Caption
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property?).

Figure 2.31 The Visual Basic Auto List Members feature.

Visual Basic Data Tips are tip tools that appear while you re debugging a program,
and they re atruly useful innovation. When Visual Basic isin the Debug state, you
can let the mouse rest over avariable name in your code, and Visual Basic will
display that variable s current value in a Data Tip, as shown in Figure 2.32.

Figure 2.32 The Visua Basic Data Tips feature.

TIP: Notethat Data Tips can only display the values of simple variables, not
complex ones like objects or arrays. For those objects, you must use either the
Immediate window or the Watch window.

Syntax Checking speaks for itself when you move the text insertion point away
from aline of Visual Basic code while writing that code, Visual Basic will check
the line s syntax and display an error box if thereis an error. That can get annoying
If you re the type of programmer who likes to move around in afile while writing
code ( What was the name of that variable again?).

Y ou can turn all of these features on and off following these steps:
1. Select the Options item in the Tools menu.

2. Select the Editor tab in the Options box, as shown in Figure 2.33.

Figure 2.33 Selecting Auto List Members, Data Tips, and more.

3. Select the options you want from the checkboxes. Auto Syntax Check, Auto List
Members, Auto Quick Info, and Auto Data Tips. That sall it takes.
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Displaying Or Hiding IDE Windows

You refeeling cramped isit your chair? Y our office? No, thistime, it s your screen.
With the proliferation of windowsin the Visual Basic IDE, there seemsto always
be more and more of them clamoring for your attention. Want to clear some IDE
windows out to make room for the important ones? Just close the windows by
clicking their close buttons (the button marked x in the top right of the window).

Whoops now you need the Form Layout window back. But how do you get it back?
Or how would you get the toolbox back if it disappeared? Or the Properties
window? The solution is easy: All you have to do isto select the window you want
to show again in the View menu, and it || reappear. Open the View menu as shown
in Figure 2.34, and click the name of the window you want to make visible again it
Sthat smple.

Figure 2.34 Specifying visible IDE windows in the View menu.

Thisisasimpletask indeed, but it s worth including here; more than one
programmer has panicked after closing the toolbox by mistake and wondering if
Visual Basic must be reinstalled to get it back!

Searching An Entire Project For Specific Text Or A Variable s
Definition

Forms, modules, class modules, MDI forms how are you supposed to keep them all
straight? These days, there are more files than ever in aVisual Basic project, and
anything that can give you an overview can help. The Project Explorer is one such
tool. This window gives you an overview of your entire project, organized into
folders.

However, there are times when that s not good enough times when you need more
details. One such occasion is when you want to find al the occurrences of specific
text throughout an entire project for example, you might want to find all the places a
particularly troublesome variable is used. To do that, you can now just use the Edit
menu s Find item. Selecting that item opens the Find box, as shown in Figure 2.35.
Now you can search all the code in an entire project if the code window is open just
click the Current Project option button before searching, as shown in Figure 2.35.

Figure 2.35 Searching for text throughout a whole project.

Even if you re familiar with searching for text throughout an entire project, there s
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one more capability that you might not know about jumping to avariable s or
procedure s definition just by clicking it. To jump to avariable s or procedure s
definition, just right-click that variable or procedure any place it s used in the code.
Doing so opens a pop-up menu, as shown in Figure 2.36.

Figure 2.36 Finding avariable s definition.

To jump to the variable s or procedure s definition, just select the Definition item in
the pop-up menu. Thisis very useful when, for example, you ve set up anew
procedure somewhere but can t quite remember what parameters you pass to that
procedure, and in what order.

TIP: Besidesjumping to avariable or procedure s definition in code, you can also
jump to its previous use in code just select the pop-up menu s Last Position item.

Optimizing For Fast Code, Small Code, Or A Particular Processor

Y our project works the way you want it, but now the users are complaining about
the size of the EXE file. Isn t there any way to make it less than 500MB? Well, that
might be a bit of an exaggeration, but Visual Basic does |et you optimize your
project in several different ways, and one of them is to optimize the code for size.

To optimize your program for code size or speed, follow these steps:
1. Select the Propertiesitem in the Visual Basic Project menu.

2. The Project Properties box opens, as shown in Figure 2.37. Select the Compile
tab in that box.

Figure 2.37 Optimizing a project for speed or code size.
3. Select the kind of code optimization you want in the
" Properties box:

" Optimize For Fast Code

" Optimize For Small Code

" No Optimization

Besides optimizing for code size and speed, you can optimize the code for the
Pentium Pro processor in the Project Properties box as well just click the Favor
Pentium Pro checkbox. The Pentium Pro is currently the only processor Visual
Basic lets you optimize for, but it does have one automatic check: the FDIV check
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to check for bad Pentiums (see Checking For Pentium Errors earlier in this
chapter).

Adding And Removing Forms, Modules, And Class Modules

Your project is nearly finished. Now it stime to add an About dialog box. So how
do you add new formsto a project? Y ou do that in one of a couple of ways. First,
you can use the View menu, as shown in Figure 2.38.

Figure 2.38 Adding forms and modules with the Visual Basic Project menu.

The Visual Basic Project menu alows you to add these items to a project:

Form

" MDI form

" Module
Class module

" User control

Property page

Y ou can also add these items to a project by right-clicking any item in the Project
Explorer window and selecting the Add item in the resulting pop-up menu. The Add
submenu opens, and it holds the same items.

Adding ActiveX Designers

Besides ready-made objects like forms and modules, you can add ActiveX designers
to the Visual Basic Project menu. These designers let you design new objects that
are part of your project. For example, to add the Visual Basic Add-In Designer, you
follow these steps:

1. Select the Components item in the Project menu, opening the Components box
as shown in Figure 2.39.

Figure 2.39 Adding the Add-In Designer.

2. Select the Designers tab in the Components box.

3. Select the designer you want to add, such as the Add-In Designer, and close the
Components box.

4. Y ou can reach the new object designer to design the addition to your project with
the Add ActiveX Designer item in the Project menu. That item opens a submenu
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showing the available designers, including the one we ve just added, the Visual
Basic Add-In Designer.
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Using Bookmarks

It sbeen along night and it s nearly dawn, but you re still programming because the
deadline sin afew hours. Now you ve lost your place in the dozen separate code
files that make up the project. There are 10 separate windows open in the IDE and
you re switching back and forth between them. Isn t there a better way to mark a
location and jump back to it when you need to?

There certainly is you can use a bookmark. Y ou mark aline of code by toggling a
bookmark on or off at that location, and when you re ready you can jump back to
that bookmark.

Setting Bookmarks

Y ou set abookmark at a particular line of code by clicking that line of code and
selecting the Toggle Bookmark item in the Bookmarks submenu of the Edit menu,
as shown in Figure 2.40. Selecting this same item again would remove the
bookmark.

Figure 2.40 Using bookmarksin the Visual Basic IDE.
Jumping To A Bookmark

Now that you ve set a bookmark and moved away from it while editing your code,
how do you get back to it? Y ou jump back to a bookmark with the two itemsin the
Bookmarks submenu marked Next Bookmark and Previous Bookmark. (It would be
convenient if Visual Basic allowed you to name bookmarks and select from allist of
them where to jump to; perhaps that will appear in some future version of Visual
Basic.)

Using The Object Browser

One of the best ways of getting an overview of your project isto use the Object
Browser. The Object Browser isvery useful to get overviews, especially in larger
projects. If your version of Visual Basic includes the Visual Basic Object Browser,
you open it by selecting the Object Browser item in the View menu or by clicking
itsicon in the toolbar. The Object Browser opens, as shown in Figure 2.41.

Figure 2.41 The Visual Basic Object Browser provides an overview of the objects
In a project.

Y ou can scan through all the objects in the project by moving up and down in the
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Classes list. When you find the type of object you want to examine, select it; its
properties and methods appear in the Members pane, as a'so shown in Figure 2.41.

If you want to learn more about a property or method, just select it with the mousg;
you |l see an explanation of the property or method and the list of parameters for
methods.
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Chapter 3
The Visual Basic Language

If you need an immediate solution to:
Declaring Constants

Declaring Variables

Selecting Variable Types

Converting Between Data Types

Setting Variable Scope

Verifying Data Types

Declaring Arrays And Dynamic Arrays
Declaring Subroutines

Declaring Functions

Preserving Variables Values Between Calls To Their Procedures
Handling Strings

Converting Strings To Numbers And Back Again
Handling Operators And Operator Precedence
Using | f& Else Statements

Using Select Case

Making Selections With Switch() And Choosg()
L ooping

Using Collections

Sending Keystrokes To Other Programs
Handling Higher Math

Handling Dates And Times

Handling Financial Data

Ending A Program At Any Time
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In Depth

This chapter is all about what makes the various parts of a Visual Basic program work: the Visual Basic
language itself. In this chapter, we |l see the components of the Visual Basic language and how to use them.
After designing and creating the interface for your application using the Visual Basic IDE, and filling your
program with forms and controls, you Il need to write the code that makes those controls and forms do
something.

The Visual Basic language supports alarge number of programming constructs and elements, and that
language is the foundation on which we Il build in thisbook. A good start here is essential for the work wel|
do throughout the book.

If you ve programmed in other languages, much of the material in this chapter will probably be familiar to
you and once you understand the basics, you will be able to create powerful applications using Visual Basic.

How Does Visual Basic Code Look?

We re going to take alook at the elements of the Visual Basic language that will let us make Visual Basic
code work. What will that code look like? Some of our code will be short, such as when we check for
multimedia device errors like thisin Chapter 22:

Private Sub MMControl 1 _Done(NotifyCode As I nteger)
| f MMControl 1. Error <> 0 Then
MsgBox MMControl 1. Error Message
End | f
End Sub

Some of our code will be alittle longer, such as this code, where we display the status of a CD-ROM drive
that s playing amusic CD:

Private Sub MMControl 1_St at usUpdat e()
Dim strMde As String
strMbde = ""

Sel ect Case MMControl 1. Mode
Case nti MbdeReady
strMde = "Ready."

Case nti MbdeSt op
strMde = " Stopped. "

Case nti MbdeSeek
striMbde = "Seeking."
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Case nti ModePl ay
strivbde = "Pl aying."

Case nti MbdeRecord
strMde = "Recording."

Case nti MbdePause
str Mode = "Paused. "

End Sel ect

Label 1. Capti on = strMde

End Sub

That swhat the Visual Basic language looks like at work. As you can imagine, knowing how to write the
code is necessary to get anywhere in Visual Basic.

In the topics coming up, then, we |l see how to declare variables, functions, and subroutines and what those
elements mean. We Il see how to use text strings, conditionals, operators, loops, and math techniques. Well
even see how to handle special Visual Basic formats like dates and financial data. And we |l see someitems
that programmers like but don t often encounter in programming books, such as how to use Switch() and

Choose().

Well cover tasks that involve some complexity and whose syntax is hard to remember. In thisway, this
chapter also acts as areference for easy lookup of those hard-to-remember items and can save you from
reinventing the whesl.

Well see alot of syntax in this chapter, and there s one convention you should be aware of before starting:
we |l use brackets for optional elements and keywords like this for the Dim statement:

Dim[WthEvents] varnanme [([subscripts])] [As [New] type] [, [WthEvents]
varname[ ([ subscripts])] [As [ New type]]

Here, al the elementsin square brackets are optional, and the variable names in italics are placeholders you
fill them in with the names of your variables as appropriate for your program

It stime to turn to the Immediate Solutions now no further introduction is needed.

Immediate Solutions
Declaring Constants

Y ou vefilled your code with numeric values and now it stime to change them al as you start work on the
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new version of the software. What a pain to have to track down and change al the numeric values (called
magic numbers) throughout all the code. Isn t there a better way?

Thereis: Use constants and declare them all in one place, then refer to the constants by name throughout the
code instead of hardwiring numeric values in the code. When it stime to change those values, you just
change the constants, al in one well-defined part of the code.

How do you use constants? Y ou declare constants in Visual Basic with the Const statement:

[Public | Private] Const constnanme [As type] = expression

The Public keyword is used at the module level to make a constant global. This keyword is not allowed in
procedures. The Private keyword is used at the module or form level to declare constants that are private,
which means only available within the module or form where the declaration is made. Like the Public
keyword, Privateis not allowed in procedures (constants in procedures are a\ways private anyway). The
constname identifier is the actual name of the constant. The type identifier is the data type of the constant,
which may be Byte, Boolean, Integer, Long, Currency, Single, Double, Date, String, or Variant. The
expression identifier holds the value you want for this constant. It may be aliteral, other constant, or any
combination that includes all arithmetic or logical operators (except the | s operator).
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Y ou can use a constant anywhere you can use any Visual Basic expression, and you usually use them for
numeric or string values that you want to use many placesin a program. That way, when you want to
modify the value of the constant, you only have to change it in its declaration, not in many places around
the program. Also, constants don t change their values, which can make them more useful than variablesin
certain circumstances.

TIP: You cant use variables, user-defined functions, or intrinsic Visual Basic functions in expressions
assigned to constants.

Here s an example showing how to declare and use a constant:

Private Sub Commandl O i ck()
Const Pi = 3.14159
Di m Radi us, Area

Radi us = 1#

Area = Pi * Radius * Radius

MsgBox ("Area =" & Str(Area))
End Sub

Declaring Variables

Before using variables, you have to set aside memory space for them after al, that swhat they are,
locations in memory. Usually, you use the Dim statement to declare variables, although you can also use
the Private (declare a private variable), Public (declare a global variable), Static (declare a variable that
holds its value between procedure calls), ReDim (redimension a dynamic array), or Type (declare a
user-defined type) keywords to declare variables, aswe |l seein the tasks covered in this chapter.

The Dim Statement

Here s how you use the Dim statement:

Dm[WthEvents] varname[ ([subscripts])] [As [New] type] [, [WthEvents]
varnane [ ([subscripts])] [As [New] type]]

The WithEvents keyword is valid only in class modules. This keyword specifies that varname is an object
variable used to respond to eventstriggered by an ActiveX object. The varname identifier is the name of
the variable you are declaring. Y ou use subscriptsif you re declaring an array.

Y ou set up the subscripts argument this way:

[lower To] upper [, [|lower To] upper]
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TIP: InVisua Basic, you may declare up to 60 dimensions for an array.

The New keyword enables creation of an object. If you use New when declaring the object variable, a new
instance of the object is created on first reference to it. This means you don t have to use the Set statement
to assign the object reference. Here s an example:

Di m Dat aSheet As New Wr ksheet

The type argument specifies the data type of the variable, which may be Byte, Boolean, I nteger, L ong,
Currency, Single, Double, Date, String (for variable-length strings), String * length (for fixed-length
strings), Object, Variant, a user-defined type, or an object type. If you don t specify atype, the default is
Variant, which means the variable can act as any type.

TIP: By default in Visual Basic, numeric variables areinitialized to 0, variable-length strings are
initialized to a zero-length string ( ), and fixed-length strings are filled with zeros. Variant variables are
initialized to Empty.

Here s an example of declaring variables using Dim:

Dl m Enpl oyeel D As | nt eger
D m Enpl oyeeNane As String
Di m Enpl oyeeAddress As String

Implicit Declarations And Option Explicit

Following the traditions of earlier versions of Basic, you don t actually need to declare avariable at all to
useit just using it in code declaresit asavariant if it s not been declared. It s better to require al variables
to be explicitly declared, however, because misspelling a variable name can declare a new variable and
cause problems, as we saw in this code from Chapter 1, where we think we re toggling a Boolean variable
named xNow but are placing the result in a new and misspelled variable named xNoww:

Private Sub Command _C i ck(1ndex As I|nteger)

I f xNow Then

Command( | ndex) . Capti on = "x"
El se

Command( | ndex) . Caption = "o"
End If

XxNoww = Not XxNow

End Sub
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To force variable declarations to be explicit (that is, to insist that each variable be declared), add the
Option Explicit statement at the module or form level to the (General) declarations object.

Selecting Variable Types

It stime to create a new variable but what type should you use? For that matter, exactly what type of
variable types are there and what do they do? Even if you remember what types there are, you probably
won t remember the range of possible values that variable type allows.
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There sawide range of datatypes, so well use atable here. The Visual Basic
variable types appear in Table 3.1 for reference, making selecting the right type a
little easier (note that although Visual Basic lists a Decimal variable type, that type
isnot yet actually supported). We also include the literal suffix symbolsfor numeric
valuesin Table 3.1 those are the suffixes you can add to the end of values or
variablesto tell Visual Basic their type, like strUser For matString$.

Table3.1

Variable types.
Type Storage Suffix
Range
Boolean 2 N/A True, False
Byte 1 N/A 0to 255
Currency 8 @ -922,337,203,685,477.5808 to
922,337,203,685,477.5807
Date 8 #&# 1 January 100 to 31 December 9999 and times
from 0:00:00 to 23:59:59
Decimal 12 N/A -79,228,162,514,264,337,593,543,950,335 to
79,228,162,514,264,337,593,543,950,335
Double 8 # -1.79769313486232E308 to
-4.94065645841247E-324 for negative values
and from 4.94065645841247E-324 to
1.79769313486232E308 for positive values
| nteger 2 % -32,768 to 32,767
Long 4 & -2,147,483,648 to 2,147,483,647
Object 4 N/A N/A
Single 4 ! -3.402823E38 to -1.401298E-45 for negative

values and from 1.401298E-45 to 3.402823E38
for positive values
String N/A $ A variable-length string can contain up to
approximately 2 billion characters; a fixed-length
string can contain 1 to approximately 64K
characters
User-defined  N/A N/A N/A
data type
Variant N/A N/A  N/A

Asyou canseein Table 3.1, Visual Basic has alarge number of dataformats. The
Variant type deserves special mention, because it s the default variable type. If you
don t declare atype for avariable, it is made a variant:
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Private Sub Commandl O i ck()
Di m Nunber Tr ai ns

End Sub
In this case, the variable Number Trainsis a variant, which meansit can take any
type of data. For example, here we place an integer value into Number Trains (note

that we specify that 5 is an integer by using the percent sign [%] suffix as specified
in Table 3.1):

Private Sub Commandl O i ck()
Di m Nunber Tr ai ns
Nunmber Trai ns = 5%

End Sub

We could have used other data types as well; here, for example, we place a string
into NumberTrains:

Private Sub Conmandl di ck()
Di m Nunber Tr ai ns
Nunber Trains = "Five"

End Sub

And here we use afloating point value (! is the suffix for single values):

Private Sub Conmandl d i ck()
Di m Nunber Tr ai ns
Nunber Trai ns = 5. 00!

End Sub

Be careful of variants, however they waste time because Visual Basic hasto
translate them into other data types before using them, and they also take up more
space than other data types.

Converting Between Data Types

Visual Basic supports a number of ways of converting from one type of variable to
another in fact, that s one of the strengths of the language. The possible conversion
statements and procedures appear in Table 3.2.
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Table3.2

Visual Basic

data

CoNversion  \ysa This
functions.
ToDoThis

ANSI value
to string .
String to
lowercase or Format, L Case, UCase
uppercase
Dateto
serial DateSerial, DateValue
number
Decimal
number to Hex, Oct
other bases
Number to
string

One data CBool, CByte, CCur, CDate, CDbl, CDec, CInt, CLng, CSng,

typeto CStr, CVar, CVErr, Fix, Int
another

Date to day, Day, Month, Weekday, Y ear
month,
weekday, or
year
Timeto
_hour, Hour, Minute, Second
minute, or
second
String to
ASCII value
String to val
number
Timeto
serial TimeSerial, TimeValue
number

Format, Str

Asc

TIP: Note that you can cast variables from one type to another in Visua Basic
using the functions CBool(), CByte(), and so on.
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Setting Variable Scope

Y ou ve just finished creating a new dialog box in your greeting card program, and it
sabeauty. However, you realize there s a problem: the user enters the new number
of balloons to display the greeting card in TextBox1 of the dialog box, but how do
you read that value in the rest of the program when the user closes the dialog box?

It stempting to set up aglobal variable, intNumber Balloons, which you fill in the
dialog box when the user clicks on the OK button. That way, you |l be able to use
that variable in the rest of the program when the dialog box is closed. But in this
case, you should resist the temptation to create aglobal variable it s much better to
refer to the text in the text box this way (assuming the name of the dialog form you
ve created is Dialog):

intNumberBalloons = Dialog. TextBox1.Text
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This avoids setting up a global variable needlessly. In fact, one of the most important aspects of Visual Basic
programming is variable scope. In general, you should restrict variables to the smallest scope possible.

There are three levels of variable scope in Visua Basic, asfollows:

Variables declared in procedures are private to the procedure.

Variables declared at the form or module level in the form or module s (General) section using Dim,
ReDim, Private, Static, or Type are form- or module-level variables. These variables are available
throughout the module.

" Variables declared at the module level in the module s (General) section using Public are global and are
available throughout the project, in all forms and modules. Note that you cannot use Public in procedures.

Y ou can get an overview of the scope of variablesin aVisua Basic project in Figure 3.1.

Figure 3.1 Visual Basic s variable scope schematic.

For more information, see the discussion of variable scope in Chapter 1.

TIP: If you use the Option Private M odule statement in a module or form, all variables in the module or
form become private to the module, no matter how they are declared.

Verifying Data Types

Y ou can change a variable s type with ReDim in Visual Basic, assign objectsto variables using Set, and
even convert standard variables into arrays. For these and other reasons, Visual Basic has a number of data
verification functions, which appear in Table 3.3, and you can use these functions to interrogate objects and
determine their types.

Table 3.3 Data
verification
functions. Does This
Function
IsArray() Returns True if passed an array
I sDate() Returns True if passed a date
I sSEmpty() Returns True if passed variable is uninitialized
IsError() Returns True if passed an error value
IsMissing() Returns True if value was not passed for specified parameter in procedure call
I sSNull() Returns Trueif passed NUL L
| sSNumeric() Returns True if passed a numeric value

IsObject() Returns True if passed an object
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Note in particular the IsMissing() function, which many programmers don t know about; this function tells
you if the call to the current procedure included a value for a particular variant. For example, here s how we
check if the call to a subroutine CountFiles() included a value in the optional parameter intM axFiles:

Sub CountFiles(Optional intMaxFile As Variant)
I f IsMssing(intMaxFile) Then
“int MaxFi | es was not passed

El se

End |f
End Sub

Declaring Arrays And Dynamic Arrays

It stime to start coding that database program. But wait a moment how are you going to handle the data? It s
just asimple program, so you don t want to start tangling with the full Visual Basic database techniques. An
array would be perfect; how do you set them up again?

Y ou can use Dim (standard arrays), ReDim (dynamic arrays), Static (arrays that don t change when between
callsto the procedure they rein), Private (arrays private to the form or module they re declared in), Public
(arrays global to the whole program), or Type (for arrays of user-defined types) to dimension arrays.

We ll start with standard arrays now.
Standard Arrays

Y ou usually use the Dim statement to declare a standard array (note that in Visual Basic, arrays can have up
to 60 dimensions):

Dm[WthEvents] varnane [([subscripts])] [As [New] type] [, [WthEvents]
varnane [ ([subscripts])] [As [New] type]]

The WithEvents keyword is valid only in class modules. This keyword specifies that varname is an object
variable used to respond to events triggered by an ActiveX object. The varname identifier is the name of the
variable you are declaring.

Y ou use subscripts to declare the array. Y ou set up the subscripts argument this way:

[l ower To] upper [, [|ower To] upper]

The New keyword enables creation of an object. If you use New when declaring the object variable, a new
instance of the object is created on first reference to it.

The type argument specifies the data type of the variable, which may be Byte, Boolean, Integer, L ong,
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Currency, Single, Double, Date, String (for variable-length strings), String * length (for fixed-length
strings), Object, Variant, a user-defined type, or an object type. If you don t specify atype, the default is
Variant, which means the variable can act as any type.

Here are afew examples of standard array declarations:

Private Sub Conmmandl_d i ck()
Di m Dat a( 30)
Dim Strings(10) As String
Dim TwoDArray(20, 40) As I|Integer
D m Bounds(5 To 10, 20 To 100)
Strings(3) = "Here's a string!”
End Sub

TIP: You usethe Option Base statement at the form- or module-level to set the lower bound for all arrays.
The default value is 0, but you can use either of these two statements. Option Base 0 or Option Base 1.

Dynamic Arrays

Y ou can use the Dim statement to declare an array with empty parentheses to declare a dynamic array.
Dynamic arrays can be dimensioned or redimensioned as you need them with the ReDim statement (which
you must also do the first time you want use a dynamic array). Here s how you use ReDim:

ReDi m [ Preserve] varname (subscripts) [As type] [, varnanme(subscripts)
[As type]]

Y ou use the Preserve keyword to preserve the data in an existing array when you change the size of the last
dimension. The varname argument holds the name of the array to (re)dimension.
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The subscripts term specifies the dimensions of the array using this syntax:

[l ower To] upper [,[lower To] upper]

The type argument specifies the type of the array. The type may be Byte, Boolean, I nteger, Long,
Currency, Single, Double, Date, String (for variable-length strings), String * length (for fixed-length
strings), Object, Variant, a user-defined type, or an object type.

Thisis one of those topics that is made easier with an example, so here s an example using dynamic arrays,
where we declare an array, dimension it, and then redimension it, like this:

Private Sub Commandl O i ck()

Dim DynaStrings() As String

ReDi m DynaStri ngs(10)

DynaStrings(1l) = "The first string"

' Need nore data space!

ReDi m DynaStri ngs(100)

DynaStrings(50) = "The fiftieth string"
End Sub

The Array() Function

Y ou can also use the Array() function to create a new variant holding an array. Here s how you use
Array():

Array(arglist)

The arglist argument isalist of values that are assigned to the elements of the array contained within the
variant. Here s an example that creates an array with the values 0, 1, and 2:

Dm A As Vari ant
A = Array(0, 1, 2)

TIP: If you don t specify any arguments, the Array() function returns an array of zero length.

We ll finish this topic with a summary of array-handling techniques.
Array-Handling Techniques Summary

Visual Basic has a number of statements and functions for working with arrays, and they appear in
overview in Table 3.4 for easy reference.
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Table3.4
Array-handling
techniques. To Do Use This
This
Verify an array |SArray
Create an array Array
Change default lower '
it Option Base
Declare and initialize Dim, Private, Public, ReDim, Static
an array
Find the limits of an L Bound. UBound
array ’

Reinitialize an array Erase, ReDim

Declaring Subroutines

Everyone knows about subroutines: they re the handy blocks of code that can organize your code into
single-purposed sections to make programming easier. Unlike functions, subroutines do not return values;
but like functions, you can pass values to subroutines in an argument list.

For reference s sake, here s how you declare a subroutine:

[Private | Public | Friend] [Static] Sub name [(arglist)]

[ st at enent s]

[ Exit Sub]

[ st at ement s]

End Sub

The Public keyword makes a procedure accessible to all other procedures in all modules and forms. The
Private keyword makes a procedure accessible only to other procedures in the module or form in which it
Isdeclared. The Friend keyword is used only in class modules and specifies that the procedure isvisible
throughout the project, but not visible to a controller of an instance of an object. The Static keyword
specifies that the procedure slocal variables should be preserved between calls. The name identifier isthe
name of the procedure. The arglist identifier isalist of variables representing arguments that are passed to

the procedure when it is called. Y ou separate multiple variables with commas. The statements identifier is
the group of statements to be executed within the procedure.

The arglist identifier has the following syntax:

http://24.19.55.56:8080/temp/ch03\095-096.html (2 of 4) [3/14/2001 1:28:42 AM]



Visual Basic 6 Black Book:The Visual Basic Language

[Optional] [ByvVal | ByRef] [ParamArray] varnanme [()] [As type]
[ = def aul t val ue]

In arglist, Optional means that an argument is not required; ByVal means that the argument is passed by
value; ByRef means that the argument is passed by reference (ByRef isthe default in Visua Basic);
ParamArray is used as the last argument in arglist to indicate that the final argument is an array of Variant
elements; varname is the name of the variable passed as an argument; type is the data type of the argument;
and defaultvalue is any constant or constant expression, which is used as the argument s default value if
you ve used the Optional keyword.

TIP: When you use ByVal, you pass a copy of avariable to a procedure; when you use ByRef, you pass a
reference to the variable, and if you make changes to that reference, the original variable is changed.

The Exit Sub keywords cause an immediate exit from a Sub procedure. Finally, End Sub ends the
procedure definition.

You call aSub procedure using the procedure name followed by the argument list. Here s an example of a
subroutine:

Sub CountFil es(Optional intMaxFile As Variant)
If 1sMssing(intMaxFile) Then
“int MaxFi | es was not passed
MsgBox ("Did you forget sonething?")
El se

End |f
End Sub

TIP: For an overview of how to comment procedures, see the discussion in Chapter 1.

Declaring Functions

There are two types of proceduresin Visual Basic: subroutines and functions. Subroutines can take
arguments passed in parentheses but do not return a value; functions do the same but do return values
(which can be discarded). A function isablock of code that you call and pass arguments to, and using
functions helps break your code up into manageable parts.

For reference s sake, here s how you declare a function:

[Private | Public | Friend] [Static] Function nanme [(arglist)] [As type]
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[ st at enent s]

[ name = expression]
té*it Functi on]
téiatenEnts]

End Functi on
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The Public keyword makes a procedure accessible to all other proceduresin al modules and
forms. The Private keyword makes a procedure accessible only to other proceduresin the
module or form in which it is declared. The Friend keyword is used only in class modules
and specifies that the procedure is visible throughout the project, but not visible to a
controller of an instance of an object. The Static keyword specifies that the procedure s

local variables should be preserved between calls. The name identifier is the name of the
procedure. The arglist identifier isalist of variables representing arguments that are passed
to the procedure when it is called. Y ou separate multiple variables with commas. The
statementsidentifier is the group of statements to be executed within the procedure.

The arglist identifier has this following syntax:

[Optional] [ByVal | ByRef] [ParamArray] varnane [()] [As type]
[ = defaul tval ue]

In arglist, Optional means that an argument is not required; ByVal means that the argument
Is passed by value; ByRef means that the argument is passed by reference (ByRef isthe
default in Visual Basic); ParamArray isused as the last argument in arglist to indicate that
the final argument is an array of Variant e ements; varname is the name of the variable
passed as an argument; type is the data type of the argument; and defaultvalue is any
constant or constant expression, which is used as the argument s default value if you ve used
the Optional keyword. The type identifier is the data type returned by the function. The Exit
Function keywords cause an immediate exit from a Function procedure.

You call aFunction procedure using the function name, followed by the argument list in
parentheses. Y ou return a value from a function by assigning the value you want to return to
the function s name like this; name = expression. Finally, End Function ends the procedure
definition.

Here s an example showing how to use a function:

Private Sub Commandl_C i ck()

DmintResult As |Integer

I nt Result = Add1(5)

MegBox ("Result =" & Str$(intResult))
End Sub

Function Addl1l(int AddlToMe As Integer) As |nteger

Addl = i nt Add1lTove + 1
End Functi on
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Preserving Variables Values Between Calls To Their Procedures

Y ou ve written a function named Counter () to keep track of the number of times the user
clicks aparticular button. Each time the user clicks the button, you call the Counter ()
function to increment the count of button clicks, and then display the result in a message
box. But the counter never seems to be incremented; instead it always returns 1. Why?

Let slook at the code:

Private Sub Conmmandl d i ck()

DmintResult As Integer

I nt Result = Counter ()

MsgBox ("Result =" & Str$(intResult))
End Sub

Function Counter() As Integer
Di m i nt Count Val ue As I nt eger
I nt Count Val ue = intCountValue + 1
Count er = int Count Val ue
End Function
The problem here is that the counter variable, intCountValue, in the Counter () functionis

reinitialized each time the Counter () function is called (because a new copy of all the
variables local to proceduresis allocated each time you call that procedure).

The solution isto declare intCountValue as static. This means it will retain its value
between calls to the Counter () function. Here s the working code:

Private Sub Commandl_C i ck()

DmintResult As |Integer

I nt Result = Counter ()

MegBox ("Result =" & Str$(intResult))
End Sub

Function Counter() As Integer
Static intCountValue As | nteger
I nt Count Val ue = i ntCountValue + 1
Count er = i nt Count Val ue

End Functi on

In fact, you could declare the whole function static, which means that all the variablesin it
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will be static. That looks like this:

Private Sub Commandl_C i ck()

DmintResult As Integer

I nt Result = Counter ()

MegBox ("Result =" & Str$(intResult))
End Sub

Static Function Counter() As I|nteger
D m i nt Count Val ue As | nteger
I nt Count Val ue = i ntCountValue + 1
Count er = i nt Count Val ue

End Functi on

Besides declaring variables with Static, you can also use it as a keyword when declaring
functions or subroutines.

Handling Strings

Y ou ve decided to lead the way into the future by letting your users type in English
sentences as commands to your program. Unfortunately, this means that you have to parse
(that is, break down to individual words) what they type. So what was that string function
that lets you break a string into smaller strings again? We ll get an overview of string
handling in this topic.

Two Kinds Of Strings

There are two kinds of strings: variable-length and fixed-length strings. Y ou declare a
variable-length string this way:

DimstrVariableString As String

A variable-length string can contain up to approximately 2 billion characters, and it can
grow or shrink to match the data you placein it.

Y ou declare a fixed-length string this way, with an asterisk character (*) followed by the
string slength:
Dim strFixedString As String * 20

Here, we give our fixed-length string 20 characters. A fixed-length string can contain 1 to
approximately 64K characters.

The String-Handling Functions
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There are quite a number of string-handling functionsin Visual Basic. For example, you use

Left(), Mid(), and Right() to divide a string into substrings, you find the length of a string
with Len(), and so on.

For reference, the Visual Basic string-handling functions appear in Table 3.5.

Table3.5

String-handling

functions. To Do Use This
This

Compare two strings StrComp
Convert strings StrConv
Convert to lowercase
Or uppercase
Cresate string of

Format, L Case, UCase

repeating character Space, String
Find length of a
' Len
string
Format a string Eormat
Justify astring L Set. RSet
Manipulate strings InStr, Left, LTrim, Mid, Right, RTrim, Trim
Set siing Somparison Option Compare
rules
Work with ASCII

and ANSI values Asc, Chr

http://24.19.55.56:8080/temp/ch03\096-101.html (4 of 4) [3/14/2001 1:28:45 AM]



Visual Basic 6 Black Book:The Visual Basic Language

Converting Strings To Numbers And Back Again

You reall set to write your SuperDeluxe calculator program in Visual Basic but suddenly you
realize that the user will be entering numbersin text form, not in numeric form. How can you
trandlate text into numbers, and then numbersinto text to display your results?

It scommon in Visual Basic to have to convert values from numbers to strings or from strings to
numbers, and it s easy to do. Y ou can use the Str() to return a string representation of a number, and
you use Val() to convert astring to anumber. That sall thereistoit, but it s easy to forget those
two functions, so we include them here for reference.

Besides Str() and Val(), you can also use For mat(), which lets you format an expression into a
string this way:

Format (expression [, format[, firstdayofweek[, firstweekofyear]]])

Here, expression is the expression to format into the string, format is avalid named or user-defined
format expression, firstdayofweek is a constant that specifies the first day of the week, and
firstweekofyear is a constant that specifies the first week of the year.

For more information about how to use this function and format strings, see Handling Dates And
Time Using Dates later in this chapter.

Handling Operators And Operator Precedence

Y ou ve done well in your computer class so well that the instructor has asked you to calculate the
average grade on the final. Nothing could be easier, you think, so you put together the following
program:

Private Sub Commandl_C i ck()

DmintGadel, intGade2, intGade3, NunberStudents As |nteger

I nt G adel = 60

I nt Gade2 = 70

I nt G ade3 = 80

Nunmber St udents = 3

MsgBox ("Average grade = " &

Str(intGadel + intGade2 + intGade3 / Nunber Students))

End Sub

When you run the program, however, it calmly informs you that the average score is 156.66666667.
That doesn t look so good what swrong?
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The problem liesin thisline:

Str(intGadel + intGade2 + intGade3 / Nunber Students))

Visual Basic evaluates the expression in parentheses from left to right, using pairs of operands and
their associated operator, so it adds the first two grades together first. Instead of adding the fina
grade, however, it first divides that grade by Number Students, because the division operation has
higher precedence than addition. So the result is 60 + 70 + (80/3) = 156.66666667.

The solution here is to group the values to add together this way using parentheses:

Private Sub Conmmandl d i ck()

DmintGadel, intGade2, intGade3, Nunber Students As | nteger

I nt G adel = 60

I nt G ade2 = 70

I nt G ade3 = 80

Nunber St udents = 3

MsgBox ("Average grade = " &

Str((intGadel + intGade2 + intGade3)/ Nunber Students))

End Sub

Running this new code gives us an average of 70, asit should be.

This example points out the need to understand how Visual Basic evaluates expressions involving
operators. In general, such expressions are evaluated left to right, and when it comes to a contest
between two operators (such as + and / in the last term of our original program), the operator with
the higher precedence is used first.

Visual Basic s operator precedence, arranged by category, appearsin Table 3.6.
Table3.6

Operators and
operator
precedence.  ComparisonL ogical
Arithmetic
Expon(?\er;tlatlon Equality (=) No
; Inequalit
Negation (-) e(q;>) y And
Multiplication
and division -S> than or
*, /) (<)
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Integer Greater than

division () >) Xor
Modulus L ess than or
arithmetic ual to (<=) Eqv
(Mod) &
Addition and Greater than
subtraction (+, or equal to Imp
) (>=)
String Like
concatenation Is
(&)

When expressions contain operators from more than one category in Table 3.6, arithmetic operators
are evaluated first, comparison operators are evaluated next, and logical operators are evaluated |ast.
Also, comparison operators actually all have equal precedence, which means they are evaluated in
the left-to-right order in which they appear.

If in doubt, use parentheses operations within parentheses are always performed before those
outside. Within parentheses, however, operator precedence is maintained.

Using If&Else Statements

The If statement is the bread and butter of Visual Basic conditionals, but you can forget the syntax
every now and then (that is, isit Elself or Else [f?), so here sthe I f statement:

| f condition Then

[ st at enent s]

[ El self condition-n Then
[el seifstatenents]]. ..

[ El se

[ el sest at enent s] ]

End If

And here s an example showing how to use the various parts of this popular statement:

Dimintlnput
i ntlnput = -1

While intlnput <0

I nt 1 nput = | nput Box("Enter a positive nunber")
Wend
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If intlnput = 1 Then
MsgBox (" Thank you.")

Elself intlnput = 2 Then
MsgBox ("That's fine.")

El self intlnput >= 3 Then
MsgBox ("Too big.")

End If

Using Select Case

Y ou have to get a value from the user and respond in several different ways, but you don t look
forward to along and tangled series of |f& Then& Else statements. What can you do?

If your program can handle multiple values of a particular variable and you don t want to stack up a
lot of |f& Else statements to handle them, you should consider Select Case. Y ou use Select Caseto
test an expression, seeing which of several cases it matches, and execute the corresponding code.
Here sthe syntax:

Sel ect Case testexpression
[ Case expressionlist-n

[ stat enment s-n]]

[ Case El se

[ el sestat enent s] ]

End Sel ect
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Here s an example using Select Case. In this example, we read a positive value from the user and test it,
responding according to its value. Note that we also use the Select Case | s keyword (not the same asthe I's
operator) to check if the value we read in is greater than a certain value, and Case Else to handle values we
don t explicitly provide code for. Here s the example:

D mintl nput
intlnput = -1

While intlnput <0

I ntl nput = I nput Box("Enter a positive nunber")
Wend
Const intMax = 100

Sel ect Case intlnput

Case 1:

MsgBox (" Thank you.")
Case 2:

MsgBox ("That's fine.")
Case 3:

MsgBox ("Your input is getting pretty big now ..")
Case 4 To 10:
MsgBox ("You are approaching the maxi nrum ")
Case |s > int Max:
MsgBox ("Too big, sorry.")
Case El se:
MsgBox ("Please try again.")
End Sel ect

Making Selections With Switch() And Choose()

For some reason, few books on Visual Basic cover the Switch() and Choose() functions. They certainly have
their uses, however, and we |l take alook at them here.

The Switch() Function

The Switch() function evaluates alist of expressions and returns a Variant value or an expression associated
with the first expression in the list that is true. Here s the syntax:
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Switch (expr-1, value-1[, expr-2, value-2 ... [, expr-n, value-n]])

In this case, expr-1 isthe first expression to evaluate; if true, Switch() returns value-1. If expr-1isnot True
but expr-2 is, Switch() returns value-2 and so on.

Here s an example showing how to use Switch(). In this case, we ask the user to enter a number and use
Switch() to calculate the absolute value of that value (having temporarily forgotten how to use the built-in
Visual Basic absolute value function, Abs()):

Di mint Val ue

i nt Val ue = | nput Box("Enter a nunber")

i nt AbsValue = Switch(intValue < 0, -1 * intValue, intValue >= 0, intValue)

MsgBox "Absolute value =" & Str(intAbsVal ue)
The Chooseg() Function

Y ou use the Choosg() function to return one of a number of choices based on an index. Here s the syntax:

Choose (index, choice-1 [, choice-2, ... [, choice-n]])
If theindex valueis 1, thefirst choiceisreturned, if index equals 2, the second choice is returned, and so on.

Here s an example using Choose(). In this case, we have three employees Bob, Denise, and Ted with
employee IDs 1, 2, and 3. This code snippet accepts an ID value from the user and uses Choose() to display
the corresponding employee name:

DmintlD
intlD = -1

Wiile intID<1 O intlID > 3
intlD = | nput Box("Enter enployee's ID")
Wend

MsgBox " Enpl oyee nane = " & Choose(intlD, "Bob", "Denise", "Ted")

Looping

Many programmers have alove/hate relationship with looping, based primarily on syntax. Programmers often
have to switch back and forth these days between languages, and can find themselves writing, for example, a
C++ loop in the middle of aVisual Basic program and being taken by surprise when the compiler objects.

To makeit easier, we Il include examples here of all the Visual Basic loops, starting with the Do loop.
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The Do Loop

The Do loop has two versions; you can either evaluate a condition at the beginning

Do [{Wiile | Until} condition]
[ st at enent s]

[ Exit Do]

[ st at enent s]

Loop

or at the end:

Do

[ st at enent s]

[ Exi t Do]

[ st at enent s]

Loop [{Wiile | Until} condition]

Here s an example where we read from afile, looping until we reach the end of the file, which we check with
the end-of-file function, EOF():

Do Until EOF(1)

Li ne I nput #1, Data$

For mlL. Text Box1l. Text = Formnml. Text Box1l. Text + Dat a$
Loop

TIP: Note that the second form of the Do loop ensures that the body of the loop is executed at least once. On
the other hand, you sometimes want to make sure the loop doesn t run even once if the condition is not met.
For example, when reading from afile, you shouldn t read from afile before checking for the end of filein
casethefileis empty.

TheFor Loop

The Do loop doesn t need aloop index, but the For loop does. Here s the syntax for the For loop:

For index = start To end [Step step]
[ st at enent s]

[ Exit For]

[ st at enent s]

Next [i ndex]

Here s how to put it to work:
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Di m i nt Loopl ndex, Tot al

Total =0

For intLooplndex =1 To 10
Total = Total + 1

Next i ntLoopl ndex

TIP: Although it s been common practice to use aloop index after aloop completes (to see how many loop
iterations were executed), that practice is now discouraged by people who make it their business to write about
good and bad programming practices.

The For Each Loop

Y ou use the For Each loop to loop over elementsin an array or collection. Here sits syntax:

For Each elenent In group
[ st at enent s]

[ Exit For][statenents]
Next [el ement]

Y ou can get alook at this loop in action with an example like this one, where we display all the elements of an
array in message boxes:

DmIlDArray(l To 3)
|DArray(1l) =1
| DArray(2) 2
| DArray( 3) 3

For Each ArrayltemIn | DArray
MsgBox (Str(Arrayltem)
Next Arrayltem

The While Loop

You use aWhileloop if you if you want to stop looping when a condition is no longer true. Here sthe While
loop s syntax:

Whil e condition
[ st at enent s]
Wend

And here s an example putting While to work:
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Di mintlnput
intlnput = -1

Wiile intlnput <0
I ntl nput = | nput Box("Enter a positive nunber")
Wend

TIP: Many Visual Basic functions, like EOF(), are explicitly constructed to return values of True or False so
that you can use them to control loops such as Do and While loops.
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The With Statement

Properly speaking, the With statement is not aloop, but it can be as useful as aloop
and in fact, many programmers actually think of it asaloop. Y ou use the With
statement to execute statements using a particular object. Here s the syntax:

Wth object
[ st at enent s]
End Wth

Here s an example showing how to put With to work. Here, we use a text box,
Textl, and set several of its propertiesin the With statement:

Wth Text1

. Hei ght = 1000

.Wdth = 3000

. Text = "Welcone to Visual Basic"
End Wth

Using Collections

Using collections, you can group related items together. Collections can be
heterogeneous that is, members of a collection don t have to share the same data
type, and that can be very useful, because life doesn t always present you with
collections made up of items of the same type.

Y ou create a collection as you would any other object:

D m GarageSal eltenms As New Col | ecti on

Y ou can add members to the collection with the Add method and remove them with
the Remove method.

Y ou can also reach specific membersin the collection using the | tem method. Most
importantly, from a programming point of view, you can loop over the entire
collection using the For Each& Next statement (see the previous section, Looping

).

Collections are very useful and are one of the high points of Visual Basic. However,
because of the heterogeneous nature of their contents, they don t necessarily lend
themselves to tight and uniform coding practices (which makes some C and C++
programmers look down their noses at Visual Basic).
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Sending Keystrokes To Other Programs

It stime to print out the 349 screen spreadsheets you ve created in your new
spreadsheet program to show the boss. Regrettably, there just doesn t seem to be
any way to print them out except one at atime, using the File menu s Print item.
Can Visua Basic help here?

Yes. You can use the SendK eys() function to send keys to the program that
currently has the Windows focus, just asif you typed in those keys yourself. Using
the Alt key, you can reach the menu items in your spreadsheet s File menu. The day
IS saved, because now you can automate your printing job, even waiting until the
spreadsheet program processes the current keystroke before continuing. Here s how
you use SendK eys():

SendKeys string [, wait]

The string expression is the string you want to send to the other program. The wait
argument is a Boolean value indicating the wait mode. If False (which isthe
default), control returns right after the keys are sent. If True, the keystrokes must be
processed by the other program before control returns.

If the keys you want to send are not simple text, just embed the codes you seein
Table 3.7 in the text you send to SendK eys().

Table3.7
SendK eys()
key codes.  cgde
Key
Backspace {BACKSPACE}, {BS}, or {BK SP}
Break {BREAK}
Caps Lock {CAPSLOCK}
Del or Delete {DELETE} or {DEL}
Down arrow {DOWN}
End {END}
Enter or
Return {ENTER} or ~
Esc {ESC}
Help {HELP}
Home {HOME}
Ins or Insert {INSERT} or {INS}
Left arrow {LEFT}
Num Lock {NUMLOCK}
Page Down {PGDN}
Page Up {PGUP}
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Print Screen {PRTSC}
Right arrow {RIGHT}
Scroll Lock {SCROLLLOCK}
Tab {TAB}
Up arrow {UP}
F1 {F1}
F2 {F2}
F3 {F3}
F4 {F4}
F5 {F5}
F6 {F6}
F7 {F7}
F8 {F8}
Fo {F9}
F10 {F10}
F11 {F11}
F12 {F12}
F13 {F13}
F14 {F14}
F15 {F15}
F16 {F16}
Shift +
Ctrl N
Alt %

Here s an example showing how to use SendK eys(). Here, we give the Windows
WordPad program the focus with the Visual Basic AppActivate() function, passing
it the title of that program (which appearsin itstitle bar), and send the string Hello
from Visual Basic! to that program as follows:

AppActivate ("Docunent - WrdPad")
SendKeys ("Hello from Visual Basic!")

The result appears in Figure 3.2 now we re able to send keystrokes to another
program.

Figure 3.2 Sending keystrokes to Windows WordPad.

Handling Higher Math

WEéll, it may have been a mistake taking on that programming job from the
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astrophysics department. How do you calculate a hyperbolic cosecant anyway? Can
Visual Basic do it?

Y es, although not directly. The built-in Visual Basic math functions appear in Table
3.8.

Table 3.8

Visudl

Basic math

functions. CalculatesThis

Function
Abs Absolute value
Atn Arc tangent
Cos Cosine
Exp Exponentiation
Fix Fix places
Int Integer value
Log Log
Rnd Random number
Son Sign
Sin Sine
Sqr Square root

Tan  Tangent
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If what you want, like hyperbolic cosecant, is not in Table 3.8, use Table 3.9, which
shows you how to calculate other results using the built-in Visual Basic functions.
There s enough math power in Table 3.9 to keep most astrophysicists happy.

Table3.9

Calculated
math
functions. Calculate ThisWay
Function
Secant Sec(X) = 1/ Cos(X)
Cosecant Cosec(X) =1/ Sin(X)
Cotangent Cotan(X) = 1/ Tan(X)
Inverse sine Arcsin(X) = Atn(X / Sgr(-X * X + 1))
Inverse _ . .
cosine Arccos(X) = Atn(-X / Sgr(-X * X + 1)) + 2* Atn(1)
';‘e"czrnste Arcsec(X) = Atn(X / Sgr(X * X - 1)) + Sgn((X) - 1) * (2* Atn(1))
Inverse _ * ¥ _Ay * (D *
cosecant Arccosec(X) = Atn(X / Sgr(X * X - 1)) + (Sgn(X) - 1) * (2* Atn(1))
Inverse — *
cotangent Arccotan(X) = Atn(X) + 2 * Atn(1)
yperbolic HSIN(X) = (Exp(X) - EXp(-X)) / 2
Hyperbolic _ _
cosine HCos(X) = (Exp(X) + Exp(-X)) / 2
Hyperbolic _ i ) i
tangent HTan(X) = (Exp(X) - Exp(-X)) / (Exp(X) + EXp(-X))
Hyperbolic
T HSec(X) = 2/ (Exp(X) + EXp(-X))
Hyperbolic _ i _
Cosecant HCosec(X) = 2/ (Exp(X) - Exp(-X))
Hyperbolic _ i i ]
cotangent HCotan(X) = (Exp(X) + Exp(-X)) / (Exp(X) - Exp(-X))
Inverse
hyperbolic HArcsin(X) = Log(X + Sgr(X * X + 1))
sine
Inverse
hyperbolic HArccos(X) = Log(X + Sgr(X * X - 1))
cosine
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Inverse
hyperbolic HArctan(X) =Log((1+ X) / (1- X)) /2
tangent
Inverse
hyperbolic HArcsec(X) = Log((Sar(-X * X + 1) + 1) / X)
secant
Inverse
hyperbolic HArccosec(X) = Log((Sgn(X) * Sgr(X * X +1) + 1) / X)
cosecant
Inverse
hyperbolic HArccotan(X) =Log((X +1) /(X -1))/2
cotangent
Logarithm to

base N LogN(X) = Log(X) / Log(N)

Handling Dates And Times

One of the biggest headaches a programmer can have is working with dates.
Handling hours, minutes, and seconds can be as bad as working with pounds,
shillings, and pence. Fortunately, Visual Basic has a number of date- and
time-handling functions, which appear in Table 3.10 you can even add or subtract
dates using those functions.

Table 3.10

Visual Basic

date

keywords_ Use This
ToDo This

Get the
current date Date, Now, Time
or time
Perform_date DateAdd, DateDiff, DatePart
calculations
Return adate DateSerial, DateValue
Return atime TimeSerial, TimeValue
Set the date
or time
Timea
process

Date, Time

Timer

There s something else you should know the For mat$() function makes it easy to
format dates into strings, including times. For easy reference, see Table 3.11, which
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shows how to display the date and time in a string note how many ways there are to
do this.

Table3.11 Using

Format$() to

display dates and

times. Format Yields Thison January 1, 2000 at 1:00 A.M.

Expression

Format$(Now, m
-d-yy)
Format$(Now, m
/d/yy)
Format$(Now,
mm - dd - yy)
Format$(Now,

ddd, mmmm d, Friday, January 1, 2000
yyy)
Format$(Now, d
mmm, yyy )
Format$(Now,
hh:mm:ss 01:00:00 01/01/00
mm/dd/yy )
Format$(Now,
hh:mm:ss
AM/PM mm- dd-
yy)

1-1-00
1/1/00

01-01-00

1 Jan, 2000

01:00:00 AM 01-01-00

Y ou can also compare dates and times directly. For example, here s how you loop
until the current time (returned as a string by Time$) exceeds the time the user has
entered in atext box (for example, 15:00:00 ); when the timeis up, the program

beeps and displays a message box:

Wiil e Tinme$ < Text 1. Text
Wend

Beep

MsgBox ("Tinmes up!")

Warning! Dont use this code snippet for more than an example of how to compare
times! The eternal looping while waiting for something to happen isabad ideain
Windows, because your program monopolizes alot of resources that way. Instead,
set up aVisual Basic Timer object and have a procedure called, say, every second.
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Handling Financial Data

You finally landed that big programming job at MegaMegaBank congratul ations!
But now there s some trouble just what isan internal rate of return anyway? Visual
Basic to the rescue there are 13 Visual Basic functions devoted entirely to financial
work, and they appear in Table 3.12.

Table3.12

The Visud

Basic financial
functions. To Use This
Do This

Calculate
depreciation
Calculate
future value
Calculate
interest rate
Calculate
internal rate of IRR, MIRR

return
Calculate
number of NPer
periods
Calculate
payments
Calculate
present value

DDB, SLN, SYD
FV

Rate

| Pmt, Pmt, PPmt

NPV, PV

TIP: If you re going to be working with financial data, checkout the Visual Basic
currency datain Declaring Variables earlier in this chapter. The currency datatype
can hold values from -922,337,203,685,477.5808 to 922,337,203,685,477.5807.

Ending A Program At Any Time
Our last topic in this chapter will be about ending programs. There are times when

you want to end a program without any further ado for example, to make an Exit
menu item active. How do you do that?
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Y ou use the End statement. This statement stops execution of your program but
note that it does so immediately, which means that no Unload() or similar event
handling functions are called. End just brings the program to an end, which is what
it should do.

TIP: The Stop statement is similar to End, except that it puts the programin a
break state. Executing a Stop statement, therefore, isjust like running into a
breakpoint the debugger will come up.
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Chapter 4
Managing Forms In Visual Basic

If you need an immediate solution to:
Setting Title Bar Text

Adding/Removing Min/Max Buttons And Setting A Window s Border
Adding Toolbars To Forms

Adding Status Bars To Forms

Referring To The Current Form

Redrawing Form Contents

Setting Control Tab Order

Moving And Sizing Controls From Code
Showing And Hiding Controls In A Form
Measurements In Forms

Working With Multiple Forms

L oading, Showing, And Hiding Forms
Setting The Startup Form

Creating Forms In Code

Using The Multiple Document Interface
Arranging MDI Child Windows

Opening New MDI Child Windows

Arrays Of Forms

Coordinating Data Between MDI Child Forms (Document Views)
Creating Dialog Boxes

All About Message Boxes And Input Boxes
Passing Forms To Procedures

Minimizing/Maximizing And Enabling/Disabling Forms From Code
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In Depth

In this chapter, we |l take alook at handling formsin Visua Basic. There sagreat
deal to see about form handling, and well look at it al. We ll see how to customize
forms, how to work with multiple forms, how to support the multiple document
interface (MDI), how to coordinate MDI child forms, how to use the M sgBox() and
I nputBox() functions, how to load, hide, show, and unload forms, and much more.
We ll begin the chapter by getting an overview of Visual Basic forms.

The Parts Of A Form

Forms are the names for windows in Visual Basic (originally, you called windows
under design forms, and the actual result when running a window, but common
usage has named both forms now), and you add controls to forms in the Integrated
Development Environment (IDE).

Were designing aformin the Visual Basic IDE in Figure 4.1, and you can see
several aspects of forms there. At the top of the form is the title bar, which displays
the form stitle; here that sjust Forml. At right in thetitle bar is the control box,
including the minimizing/maximizing buttons and the close button. These are
controls the user takes for granted in most windows, although we |l see they are
inappropriate in others (such as dialog boxes).

Figure4.1 A form under design.

Under the title bar comes the menu bar, if thereisone. In Figure 4.1, the form has
one menu: the File menu (we |l see how to work with menusin the next chapter).
Under the menu bar, forms can have toolbars, as you seein the IDE itself.

The main area of aform the area where everything takes place is called the client
area. In general, Visual Basic code works with controls in the client area and leaves
the rest of the form to Visual Basic (in fact, the client areaisitself awindow). In
Figure 4.1, we ve added a control a command button to the form.

Finally, the whole form is surrounded by a border, and there are several types of
borders that you can use.

The Parts Of An MDI Form

Besides standard forms, Visual Basic also supports MDI forms. An MDI form
appearsin Figure 4.2.

Figure4.2 An MDI form.
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Y ou can see that an MDI form looks much like a standard form, with one major
difference, of course the client area of an MDI form acts like akind of corral for
other forms. That is, an MDI form can display MDI child formsin it, which is how
the multiple document interface works. In Figure 4.2, we have two documents open
inthe MDI form.

That s the third type of form you can havein Visual Basic MDI child forms. These
forms appear in MDI child windows, but otherwise are very similar to standard
forms.

Those, then, are the three types of forms available to usin Visua Basic: standard
forms, MDI forms, and MDI child forms. We |l work with all of them in this
chapter. In fact, we re ready to start getting into the details now as we turn to the
Immediate Solutions section of this chapter.

Immediate Solutions
Setting Title Bar Text

Y ou ve submitted your project to the user-testing stage and feel smug. What could
go wrong? Suddenly the phone rings seems they don t like the title in the program s
title bar: Projectl . How can you changeit?

This stymiesalot of Visual Basic programmers, because the text in the title bar
seems like something that Windows itself manages, not the program. In fact, it sup
to the program, and setting the text in thetitle bar couldn t be easier. At design time,
you just change the form s Caption property, as shown in Figure 4.3.

Figure 4.3 Setting aform s caption.

Y ou can also set the Caption property at runtime in code like this (note that we use
the M e keyword here to refer to the current form see Referring to the Current Form
later in this chapter):

Private Sub Commandl O i ck()
Me. Caption = "Hello from Vi sual Basic!"
End Sub

Adding/Removing Min/Max Buttons And Setting A Window s Border

Forms usually come with minimizing and maximizing buttons, as well asa close
box at the upper right. However, that s not appropriate in al cases, aswell see
when we design dialog boxes later in this chapter.

To remove these buttons, you can set the form s ControlBox property to False, as
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shown in Figure 4.4. Note that the usual buttons are missing from the form at the
upper right.

Figure 4.4 Removing the control box from aform.

TIP: If you are thinking of designing adialog box, take alook at Creating Dialog
Boxes later in this chapter besides removing the control box, you should also set
the dialog s border correctly, add OK and Cancel buttons, and take care of afew
more considerations.

Y ou can also set what buttons are in aform by setting its border type. For example,
iIf you set the border style to afixed type, the minimizing and maximizing buttons
will disappear.

Setting A Form s Border

Y ou set aform s border style with its Bor der Style property; here are the possible
values for that property:

' ONone

" 1Fixed Single

" 2 Sizable

' 3 Fixed Dialog

" 4 Fixed Tool window

" 5 Sizable Tool window

We Il see more about using the Bor der Style property when we work with dialog
boxes in this chapter.
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Adding Toolbars To Forms

For some reason, adding toolbarsto formsisn t covered in alot of Visual Basic books. However, users have
come to expect toolbars in more complex programs, and we Il see how to add them here. Toolbars provide
buttons that correspond to menu items and give the user an easy way to select the commands those items
correspond to.

Adding A Toolbar With The Application Wizard

The easiest way to design atoolbar and add it to a program is with the Application Wizard. When you create
anew application using the Application Wizard, it lets you design the toolbar, as shown in Figure 4.5.

Figure 4.5 Designing atoolbar with the Application Wizard.

Thisisagreat way to put atoolbar in a program, because the support is already there for all these buttons by
default. When you create the program, here s how it handles the buttons in the toolbar, with a Select Case
statement that looks at the button s Key value:

Private Sub tbTool Bar Buttondick(ByVal Button As Concttl Li b. Button)
On Error Resune Next
Sel ect Case Button. Key

Case " New'
LoadNewDoc
Case " (Open"

muFi | eOpen_d i ck
Case " Save"
muFi | eSave _d i ck
Case "Print"
muFil ePrint_Cdick
Case " Copy"
muEdi t Copy_C i ck
Case "Cut"
muEdi t Cut _d i ck
Case "Paste"
muEdi t Paste _Cick
Case "Bol d"
ActiveFormrtfText. Sel Bold = Not ActiveFormrtfText. Sel Bol d
Button. Value = Il f(ActiveFormrtfText. Sel Bold, tbrPressed, _
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t br Unpr essed)
Case "ltalic"
ActiveFormrtfText.Selltalic = Not ActiveFormrtfText.
Selltalic
Button.Value = IIf(ActiveFormrtfText.Selltalic, tbrPressed, _
t br Unpr essed)
Case "Underline"
ActiveFormrtfText. Sel Underline = Not
ActiveFormrtf Text. Sel Underli ne
Button. Value = IIf(ActiveFormrtfText. Sel Underline, _
t br Pressed, t br Unpr essed)
Case "Align Left"

ActiveFormrtfText.Sel Alignnment = rtfleft
Case "Align R ght"
ActiveFormrtfText. Sel Alignnment = rtfRi ght
Case "Center”
ActiveFormrtfText. Sel Alignment = rtfCenter
End Sel ect

End Sub

Adding A Toolbar To A Program Yourself

Y ou can also add toolbars to already-existing programs; just follow these steps.

1. Use the Project[vbar] Components item to open the Components box, and select the Controls tab.

2. Click the Microsoft Windows Common Controls box, and click on OK to close the Components box.
3. Double-click the New Toolbar tool in the toolbox to add a new toolbar to your form now.

4. Right-click the toolbar now, and select the Propertiesitem in the pop-up menu that appears, opening the
button s property page, as shown in Figure 4.6.

Figure 4.6 Setting atoolbar button s properties.

5. Click the Buttonstab in the property page now, and click Insert Button to insert a new button into the
toolbar.

6. Give the new button the caption you want, and set its K ey property to a string of text you want to refer to
the button with in code (in Figure 4.6, we set the new button s Key property to First).

7. Add other buttonsin the same way and close the property page.

8. Double-click abutton in the toolbar now to open the code window, displaying Toolbar1 ButtonClick():
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Private Sub Tool bar1l Buttondick(ByVal Button As Concttl Lib. Button)

End Sub

9. Add the code you want to Toolbar1 ButtonClick(). You do thiswith a Select Case statement, selecting
on the buttons K ey property:

Private Sub Tool barl ButtonCick(ByVal Button As Conttl Li b. Button)

Sel ect Case Button. Key

Case "First"
MsgBox "You clicked the first button.™

Case "Second”
MsgBox "You clicked the second button.™

Case "Third"
MsgBox "You clicked the third button.™

End Sel ect

End Sub

And that sit now we ve added atoolbar to a program; when the user clicks akey in the toolbar, our program
will handleit. The result appearsin Figure 4.7.

Figure 4.7 A form with atoolbar.
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Adding Status Bars To Forms

Y ou ve finished your program, and it s ready to go to market but suddenly the
project director calls and asks why there s so many message boxes popping up al
the time. Y ou explain that you have to give the user feedback on the file
downloading process after all, downloading the 200MB initialization file from the
Internet takes some time, and you like to update the user on the process every time a
kilobyte of data has been read.

What about using the status bar? the project director asks.
Hmm, you think what about using the status bar?

The easiest way to put a status bar in aform isto design your program with the
Application Wizard, and the result of that process appears earlier in Figure 4.2.
However, you can also add status bars to a program yourself with these steps:

1. Use the Project[vbar]Components item to open the Components box, and select
the Controls tab.

2. Click the Microsoft Windows Common Controls box, and click on OK to close
the Components box.

3. Double-click the New Status Bar tool in the toolbox to add a new status bar to
your form now.

4. Right-click the status bar, and select the Properties item in the pop-up menu that
appears, opening the button s property page, as shown in Figure 4.8.

Figure 4.8 Adding panelsto a status bar.

5. Status bars are organized into panels, and each panel can display separate text.
To add the panels you want to the status bar, use the Insert Panel button. Close the

property page.

6. Now you can set the text in the panels from code. Y ou do that with the status bar
s Panels collection. Thefirst panel in the status bar is Panels(1), the second
Panels(2), and so on. For example, to set the text in the first panel to Status: OK
you would use this code:

Private Sub Commandl Cick ()

StatusBar 1. Panel s(1). Text = "Status: K"
End Sub
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The result appears in Figure 4.9 now we re using status bars in our programs.

Figure4.9 A new status bar in a program.

Referring To The Current Form

Y ou ve written aterrific subroutine to change aform s color to red

Sub Col or W ndow( For nifoCol or As Form
For mloCol or. BackCol or = RGEB(255, 0, 0)
End Sub

and you want to color al the formsin your project when the user clicks a button.
That s easy to do using the M e keyword, which refersto the current object. Here,
for example, is how we d pass the current form to the Color Window() subroutine:

Private Sub Commandl_C i ck()
Col or W ndow Me
End Sub
That is, Meisanimplicit variable, dways available, and stands for the current

object, which comes in handy when you want to pass the current object to a
procedure.

TIP: The Mekeyword isalso very useful in class modules where more than one
instance of a class can occur, because it always refers to the current instance.

Redrawing Form Contents

Y ou ve written some code to draw an x across aform like this;

Private Sub Commandl O i ck()
Line (0, 0)-(ScalewWdth, Scal eHeight)
Line (0, Scal eHei ght)-(Scal ewdth, 0)
End Sub

Youtry it out and it looks perfect but then the boss walks past and you minimize
your program for a second to go back to that word-processing program so you |l
look busy. When you maximize the x program again, the x is gone what happened?

One of the biggest headaches for Windows programmersiis refreshing the window
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when required, because that involves redrawing the entire form s contents. To make
matters worse, thisis a common occurrence, because in Windows, the user is
always covering and uncovering windows, minimizing and maximizing them, and
changing their size, all of which means that your program has to keep redrawing
itself.

In C or C++ programs, you have to write all the redrawing code yourself;
fortunately, thereis an easy fix in Visual Basic (and that s one of the things that
made Visual Basic so popular in the first place) you just use the AutoReDraw
property. You ve probably already used the AutoReDraw property, but we include
it here for reference. When you set this property to True, as shown in Figure 4.10,
the graphics displayed in the form are stored and redisplayed when needed. All the
window refreshes are done for you.

Figure4.10 Setting AutoReDraw to True.

Now when you minimize and then maximize your x program, the x reappears as it
should. Problem solved!

Setting Control Tab Order

Another call from the Testing Department. They ve been going over your program
with a fine-tooth comb and asking about the keyboard interface.

What does that mean? you ask.

They explain that theoretically, according to Microsoft, users should be able to run
all Windows programs with the keyboard alone.

But that was archaic years ago, you say.
Add it to your program, they say.

In Visual Basic, you can make controls accessible to the keyboard by setting their
tab order. The user can move around from control to control, highlighting the
currently selected control, using the Tab key. But it sup to you to set the order in
which the focus moves from control to control, and even whether or not a control
can be reached with the Tab key.

To set the tab order of the controlsin your program, follow these steps:

1. Select a control whose tab order you want to set with the mouse, as shown in
Figure4.11.

Figure4.11 Setting acontrol s Tablndex property to set its tab order.
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2. Next, make sure the control s TabStop property is set to True, as shown in
Figure 4.11. If this property is False, the user cannot reach the control using the Tab

key.

3. Now set the control s position in the tab order by setting its Tabl ndex property.
Thefirst control in the tab order has a Tablndex of O, the next a Tablndex of 1,
and so on.

4. When you run the program, the first control is highlighted; when the user presses
the Tab key, the focus moves to the second control in the tab order, when he presses
Tab again, the focus moves to the third control, and so on.

That sall it takes now you re giving your program a keyboard interface.
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Moving And Sizing Controls From Code

Sometimesit s necessary to move or resize the controlsin aform as a program is
running, but for some reason, many Visua Basic programmers think you can only
do that at design time. In fact, you can do it at runtime easily.

All controls have these properties available at design time or runtime to set their
location and dimensions:

" Top They coordinate of the top left of the control.
" Left The x coordinate of the top left of the control.
' Width The width of the control.

" Height The height of the control.

Y ou can change all these settings interactively to move or resize a control in aform.
Note that all measurements are in twips (1/1440 of an inch) by default, and that the
origin (0, 0) inaformis at upper left.

Y ou can also use a control s M ove() method to move a control to a new location:

obj ect. Move left, [top, [width, [height]]]

Here s an examplein this case, when the user clicks a button, Commandl, we
double the button s width and height, and move it 500 twips to the | eft:

Private Sub Commandl_C i ck()
Const intlncrenment = 500
Commandl. Wdth = 2 * Commandl. Wdt h
Commandl. Hei ght = 2 * Commandl. Hei ght
Commandl. Move (Commandl. Left + intlncrenent)
End Sub

TIP: Oneway of creating Simple animation isto use an Image control to display an
Image and use its M ove() method to move it around aform.

Showing And Hiding Controls In A Form

The Testing Department is on the phone again does your program really need 120
buttons in the main form? After al, that s exactly what menus were designed for: to
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hide controls not needed, getting them out of the user sway. (In fact, that susually a
good way to determine if a control item should be in a menu or on the main form:
you use menus to make options available to the user at all times, while keeping
them out of the way.)

However, let s say you really don t want to put your control items into menus you
can still use buttons if you hide the ones that don t apply at a particular time,
showing them when appropriate. Hiding and showing controls in aform as needed
can produce dramatic effects at times.

Showing and hiding controlsis easy: just use the control s Visible property. Setting
this property to True displays the control; setting it to False hidesit. Here san
example where we make a button disappear (probably much to the user s surprise)
when the user clicksit:

Private Sub Commandl O i ck()
Commandl. Vi si bl e = Fal se
End Sub

Measurements In Forms

The default measurement units for forms are twips, but the project design board
says they want the data-entry forms you re designing to look like real 3x5 cards on
the screen. Can you convert from twipsto inchesin Visual Basic? Yes, you can, and
well take alook at that and other measurement issues here.

Y ou can get the dimensions of aform s client area with these properties:

" ScaleWidth The width of the client area.

' ScaleHeight The height of the client area.

" Scalel eft The horizontal coordinate of upper left of client area.

" ScaleTop The vertical coordinate of upper left of client area.

And you can get the overall dimensions of the form using these properties:
" Width The width of the form.

" Height The height of the form.

' Left The horizontal coordinate of upper left of the form

" Top The vertical coordinate of upper left of the form

Y ou can also use the ScaleM ode property to set aform s coordinate system units
you don t have to use twips. Here are the possible values for ScaleM ode :

" 0 User-defined
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" 1 Twips (1/1440ths of an inch)

' 2 Points (1/72nds of an inch)

" 3 Pixels

" 4 Characters (120 twips horizontally, 240 twips vertically)
" 51nches

" 6 Millimeters

7 Centimeters

User-Defined Coordinates

To make life easier for yourself, you can set up a user-defined coor dinate system:
just set the ScaleWidth and ScaleHeight properties yourself. For example, if you
want to plot data on a 1000x1000 grid, just set ScaleWidth and ScaleHeight to
1000. To draw a scatter plot of your data, then, you could use PSet() to set
individual pixelsdirectly. If one of the pointsto graph was (233, 599), you could
draw that dot this way: PSet(233, 599).
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Working With Multiple Forms

Y ou ve designed your program and it s a beauty: an introductory form to welcome
the user, adata-entry form to get data from the user, a summary form to display the
data analysis results, alogon form to connect to the Internet it sall there.

Suddenly it occursto you aren t Visual Basic projects organized into modules and
forms? How does the code in one form reach the code in another that is, how can
the code in the analysis modul e read what the user has entered in the data-entry
form? It stimeto take alook at working with multiple forms.

For example, let s say that your introductory form looks something like that in
Figure 4.12.

Figure4.12 A single form that |ets the user display another form.

When the user clicks the Show Form2 button, the program should display Form2
on the screen and place the text Welcome to Visual Basic in the text box in Form?2
aswell, as shown in Figure 4.13. To be able to do that, we || need to reach one form
from another in code.

Figure 4.13 A multiform program.

Create anew Visua Basic project now. This project has one default form, Form1.
To add another form, Formz2, just select the Add Form item in the Project menu;
click on OK in the Add Form dialog box that appears to accept the default new
form. In addition, add a new text box, Text1, to the new form, For m2.

In addition, add a command button to Form1 and give it the caption Show Form2
and open the code for that button now:

Private Sub Commandl_Click ()

End Sub

When the user clicks the Show Form2 button, we will show Form2, which we do
with Form2 s Show() method:

Private Sub Conmmandl d i ck()
For n2. Show
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End Sub
Next, to place the text Welcometo Visual Basic inthetext box, Textl, in Formz2,
we need to use that text box sfully qualified name: Form2.Text1, indicating that the

text box we want isin Form2. We can use that text box s Text property this way to
set the text in the box:

Private Sub Commandl_C i ck()

For n2. Show

FornR2. Text 1. Text = "Hello from Vi sual Basic"
End Sub

TIP: One useful property that controls have is the Parent property. Controls are
really child windows of the form they rein, so if you wanted to set the background
color of the form that Text1 isin and don t know that form s name, you can use the
Text1l.Parent.BackColor property.

That completes the code for the Show Form2 button. Form2 has a button labeled
Hide Form, and we can implement that by hiding For m2 in that button s event
handler procedure:

Private Sub Commandl Cick()
Hi de
End Sub

WARNING! If you hide all windowsin aVisual Basic program that has no
Main() procedure in amodule, the program will end.

And that sit we ve written a program that handles multiple forms.

TIP: You can also make variables global in aVisual Basic project by declaring
them at the module level and using the Public keyword. The code in al forms has
access to global variables (but in general, you should limit the number of global
variables you use so the global space remains uncluttered and you don t get conflicts
and unintended side effects with variables of the same name).

Loading, Showing, And Hiding Forms

There are times when you might want to work with aform before displaying it on
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the screen to initialize it (with graphics and so on), in which case you can load the
form into memory using the L oad statement.

TIP: Youdont need to load or unload forms to show or hide them the loading and
unloading processes are automatic. Y ou usually load forms explicitly only to work
on them before displaying them, as Visual Basic recommendsif you want to work
with aform before showing it. However, it actually turns out that you dont really
need to use L oad even then, because referring to aform makes Visua Basic load it
automatically. This means you don t have to load forms to use the Show() or Hide()
methods with them.

To actually show the form on the screen, then, you use the Show() method. Here s
an example in which we load a new form, For m2, and then show it:

Private Sub Commandl O i ck()

Load Forn?
For n2. Show
End Sub

TIP: If youload an MDI child window without having loaded its associated MDI
frame, the MDI frame is also loaded automatically.

After displaying aform, you can hide it with the Hide() method and unload it
(although that s not necessary) with the Unload statement. Y ou usually unload
formsif you have alot of them and are concerned about memory usage. Here s an
example in which we hide Form2 and then unload it:

Private Sub Command2_ Cick()

Forn2. H de
Unl oad For nR
End Sub

Setting The Startup Form

WEell, the program is complete, and you ve saved writing the best for last: the
opening form in which you greet the user. Unfortunately, that greeting formis
Form249, and when you actually test the program, Visual Basic pops Form1,
which is the Import File dialog box, onto the screen first. How can you make the
program start with Form249?

Y ou can set the startup form following these steps:
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1. Select the Project[vbar]Propertiesitem.

2. Select the General tab in the Project Properties box that opens, as shown in
Figure 4.14.

Figure 4.14 Setting the startup form.

3. Set the form you want as the startup form in the Startup Object box, as also
shown in Figure 4.14.

That sit now the program will display the form you ve selected first when the
program runs.
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Creating Forms In Code

Y ou ve added a handy calculator form to your financial planning program but you
find that many users have several calculations open at once and want to open
multiple calculators. How do you create and display new forms like that in Visual
Basic?

New forms are ssmply new objectsin Visua Basic. To declare a new form based on
aform you aready have, say Forml, you just use Dim :

Private Sub NewForm C i ck()
Di m NewFor m As For ml

End Sub
Next, you create the new form with the New keyword:

Private Sub NewfForm C i ck()
Di m NewFor m As For nil
Set NewForm = New Forml

End Sub
Finally, you show the new form:

Private Sub NewForm i ck()
Di m NewlFor m As For nl
Set NewForm = New For ml
NewFor m Show

End Sub

Calling this subroutine will add as many new forms as you want to a program.

Note that we do not keep track of the new form s name (NewForm isalocal
variablein NewForm_Click(), and you can t use it after returning from that
procedure); you might want to save the new formsin an array so you can close them
under program control.

Using the code, we create new forms, as shown in Figure 4.15.
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Figure 4.15 Creating and displaying new forms.

Using The Multiple Document Interface

Y ou ve written anew editor program, and it s a great success. But then you start
getting calls from the Field Testing Department: users want to open more than one
document at atime. Just how do you do that?

Y ou use MDI forms. MDI frame windows can display multiple child windows
inside them,; in fact, the Visual Basic IDE itself isan MDI frame window.

For example, if you aready have a program based on a single form, Form1, and you
want to make that into an MDI child window inside an MDI frame, follow these

steps:
1. Add anew MDI form to the project using the Project[vbar]Add MDI Form item.

2. Set the MDIChild property of the form you want to use as the MDI child form
(Form1 here) to True, as shown in Figure 4.16.

Figure4.16 Setting aformsMDIChild property to True.

3. Run the program; the form you ve made into the MDI child form appearsin the
MDI form, as shown in Figure 4.17.

Figure4.17 Creating an MDI child form

TIP: InVisua Basic, you can use al kinds of forms as MDI children in an MDI
form, aslong as their M DI Child property is set to True. Y ou can aso use Show()
and Hide() on those windows to manage them as you like.

Arranging MDI Child Windows

So you ve made your program an MDI program, just as the users asked. However,
the Testing Department is back on the phone, and they think it would be niceif you
could provide some way of arranging the MDI children in the main MDI form so it
looks tidy.

Y ou could arrange the MDI child forms with their L eft, Top, Width, and Height
properties, but there s an easier way you can use the MDI form method Arrange().

For example, if you add a menu item to an MDI form named, say, Arrange All,
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you can use the Arrange() method to arrange all the windowsin theformin a
cascade thisway:

Private Sub ArrangeAll _dick()
Me. Arrange vbCascade
End Sub

Using this method results in the cascade of MDI children seenin Figure 4.18.

Figure 4.18 Arranging MDI child forms.

The possible values to passto Arrange() to specify the way you want to arrange
MDI children appear in Table 4.1.

Table4.1 Ways
of arranging MDI

child windows. ValueDoes This

Constant
vbCascade 0 Cascades all nonminimized MDI child windows
vbTileHorizontal 1 Tiles al nonminimized MDI child forms horizontally
vbTileVertical 2 Tiles al nonminimized MDI child forms vertically
vbArrangelcons 3 Arrangesiconsfor minimized MDI child forms

Opening New MDI Child Windows

Now that you ve supported MDI, your program s users want to actually open
multiple documents how can you allow them to do that?

Y ou can do this one of two ways: first, you can create all the forms you want to use
at design time and set their Visible properties to False so they don t appear when the
program starts. When you want to show or hide them, you can use Show() or

Hide().

Y ou can also create new forms as needed see Creating Forms In Code earlier in
this chapter. For example, here we create and display anew MDI child form
(assuming Form1 s M DI Child property is set to True), aswell as setting its
caption:

Private Sub NewwW ndow Click ()

Di m NewFor m As For nl
Set NewForm = New Forml
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NewFor m Capti on = "Docunent”
NewFor m Show

End Sub

(If you want to display text in these new child forms, you might use arich text box
to cover the form s client area when you design them.)

We re adding forms thisway in Figure 4.19.

Figure4.19 Creating new MDI children from code.
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Arrays Of Forms

Now that you ve written your MDI program, you suddenly have alot of windows to
manage. The user wants to open 20 documents at the same time how can you keep track of
al that? Wouldn t it be nice if you could use arrays of formsin Visual Basic and just refer to
each form with one single array index?

Y ou can do that in Visual Basic (in fact, you can create arrays of many types of objects,
excluding such objects that there can only be one of, like the application object, App). You
create an array of formsjust as you would create an array of any other kind of object; here,
we re creating an array of Forml objects, because that s the type of form we |l use as M DI
children in an MDI program:

Dim Fornms(1 To 20) As Fornml

If we declare thisarray, Forms(), asaform-level array in the MDI form, we can refer to that
array in all proceduresin the MDI form. For example, we might want to create and display a
new MDI child form in a procedure named NewWindow_Click():

Private Sub NewW ndow C i ck()

End Sub

Next, we set up a static variable to hold the total number of MDI child forms,
Number For ms, and increment that variable now that we re adding a new form:

Private Sub NewwW ndow Cl i ck()
Stati c Nunber For ns
Nunber Forns = NunberForns + 1

End Sub
Now, we create a new form and add it to the form array:

Private Sub NewW ndow C i ck()
Stati c Nunber For ns
Nunmber Forns = Nunber Forns + 1
Set For ns( Nunmber Forns) = New For mil

End Sub
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Throughout the rest of the program, now, we re able to refer to the new form as a member of
the form array; here, for example, we set its caption and show it, referring to it with an index
value in the form array:

Private Sub NewwW ndow Click()
Static Nunber For ns
Nunmber For ns = Nunber Forns + 1
Set Fornms(Nunmber Forns) = New For nl
For ms( Nunber For ns) . Capti on = "Docunent" & Str(Nunber For ns)
For ms( Nunber For ns) . Show
End Sub

Coordinating Data Between MDI Child Forms (Document Views)

Y our new word-processor program is almost done just one more refinement to add. Y ou
want to allow the user to open multiple views into the same document. A view isjust a
window into a document, and if a document has multiple views open, the user can scroll
around in different parts of the same document at the same time. Y ou ve been able to open
the same document in severa view windows now but what if the user starts typing into one
view? All the other views should also be updated with the new text as well. How do you
keep all the open views of the same document coordinated?

Well see how this works now. In this example, the MDI child windows will be based on a
form, Form1, in which we ve placed a text box. The user can open as many MDI child
windows as they like with the New item in the Window menu. When they type in one MDI
child s text box, however, we should mirror any such changesin the other MDI children s
text boxes aswell. Thisis shown in Figure 4.20, where the text appears simultaneously in
both MDI children while the user types into one.

Figure 4.20 Coordinating MDI children.

We start by adding a new module to the program with the Project[vbar]Add Module item so
that we can set up aglobal array of forms, Forms, and an array index variable,
Number For ms, in that module:

Public Fornms(1 To 20) As Forndl
Publ i ¢ Nunber Forns As | nteger

Next, we add a Window menu to the MDI form. We also add new forms to that array of
forms when the user creates such new forms by adding this code to the MDI form s New
item in the Window menu:
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Private Sub NewwW ndow Click()
Nunmber For ns = Nunber Forns + 1
Set Fornms( Nunber Forns) = New For il
For ms( Nunber Forns) . Caption = "Docunent” & Str(Nunber For ns)
For ms( Nunber For ns) . Show
End Sub

Now the Forms array holds the MDI children in our program.

When the user types text into the text box displayed in an MDI child, we want to update all
the other MDI children as well, making them display the same text. When you type into a
text box, a Change event occurs, and we || add code to that event s handler function to
update all the other MDI children:

Private Sub Text1l Change()

End Sub

Here, we store the text in the just-changed text box and, in this ssmple example, just loop
over al MDI children, updating them to match the changed text box:

Private Sub Text1l Change()
Dim Text As String
Text = Text 1l. Text
For intLooplndex = 1 To Nunber For ns
Fornms(i nt Loopl ndex) . Text 1. Text = Text
Next i ntLoopl ndex
End Sub

Now when you change the text in one child, the text in al children is updated. In thisway,
we can support multiple views into the same document.
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Creating Dialog Boxes

It stime to ask the user for some feedback, and you don t want to use the Visual
Basic input box because that can only accept one line of text. Besides, you dont like
the way it looks (it s not a great favorite among Visual Basic programmers, perhaps
for that reason). Looks like you Il have to use a dialog box. How do they work in
Visual Basic?

To add adialog box to a project, select the Project[vbar]Add Form item. Y ou can
add asimple form and make it into adialog box, but Visual Basic already has a
predefined dialog box form, named Dialog, so select that in the Add Form box and
click Open.

TIP: To learn more about adding predefined formsto a project, see Using Visua
Basic Predefined Forms, Menus, And Projects in Chapter 2.

This adds a new dialog box to the project, as shown in Figure 4.21.

Figure4.21 A new dialog box.

This dialog box comes with an OK and Cancel button, and its Bor der Style property
is already set to 3, which creates afixed dialog-style border with only one control
button: a close button.

We add atext box, Textl, to the dialog box, as also shown in Figure 4.21. Next, we
declare a Public string, Feedback, in the dialog box s (General) section; this string
will hold the text that the user gives us as feedback:

Publ i ¢ Feedback As String
When the dialog box opens, we can initialize Feedback to the empty string:

Private Sub Form Load()
Feedback = ""
End Sub

If the user clicks the Cancel button, we want to leave the text in Feedback asthe
empty string and just hide the dialog box:

Private Sub Cancel Button di ck()
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H de
End Sub

If the user clicks OK, on the other hand, we fill the Feedback string with what the
user has typed into the text box, and then hide the dialog box:

Private Sub OKButton Cick()
Feedback = Text 1. Text
H de

End Sub

That completes the dialog box. In the program s main form, we can show that dialog
box when required this way note that we pass a value of 1 to the Show() method,
which displays our dialog box as modal. Modal means that the user must dismiss the
dialog box before continuing on with the rest of the program (the default value
passed to Show() is 0, which displays windows in a non-modal way):

Private Sub Commandl_C i ck()
D al og. Show 1

End Sub
Next, we can display the feedback that the user has given us, if any, by examining
the dialog s Feedback string this way:

Private Sub Commandl O i ck()

D al og. Show 1

Text 1. Text = D al og. Feedback
End Sub

And that sit now we are supporting dialog boxes, as shown in Figure 4.22.

Figure 4.22 Using anewly created dialog box.

TIP: Onegood rule for constructing dialog boxes. always add a Cancel button so
that if users open the dialog box by mistake, they can close it without consequences.

All About Message Boxes And Input Boxes

Visual Basic provides two ways of displaying message boxes and input dialog boxes:
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using MsgBox() and I nputBox(). We ll cover their syntax in the following
subsections.

The MsgBox() Function

Y ou use M sgBox() to display a message to the user and get areturn value
corresponding to one of the buttons in the message box. Here s the syntax:

MsgBox(pronpt[, buttons] [, title] [, helpfile, context])

The prompt argument holds the string displayed as the message in the dialog box.
(The maximum length of prompt is approximately 1,024 characters.)

TIP: If prompt is made up of more than one line, you can separate the lines using a
carriage return character (Chr(13) ), alinefeed character (Chr(10) ), or both
(Chr(13) & Chr(10) ) between each line.

The buttons argument specifies what to put into the message box, as specified in
Table 4.2. The default value for buttonsis 0.

Table 4.2 MsgBox()

constants. Constant Value Description
vbOK Only 0 Display OK button only
vbOK Cancel 1 Display OK and Cancel buttons
vbADbortRetrylgnore 2 Display Abort, Retry, and Ignore buttons
vbYesNoCancel 3 Display Yes, No, and Cancel buttons
vbYesNo 4 Display Y es and No buttons
vbRetryCancel 5 Display Retry and Cancel buttons
vbCritical 16 Display Critical Message icon
vbQuestion 32 Display Warning Query icon
vbExclamation 48 Display Warning Message icon
vblnformation 64 Display Information Message icon
vbDefaultButtonl 0 First button is default
vbDefaultButton2 256 Second button is default
vbDefaultButton3 512 Third button is default
vbDefaultButton4 768 Fourth button is default
vbApplicationM odal 0 Application modal; the user must respond to

the message box before continuing work in the
current application.
vbSystemM odal 4096 System modal; all applications are suspended
until the user responds to the message box.
vbM sgBoxHelpButton 16384 Adds Help button to the message box
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VbM sgBoxSetForeground 65536 Specifies the message box window as the
foreground window
vbM sgBoxRight 524288 Text isright-aligned
vbM sgBoxRtIReading 1048576 Specifies text should appear as right-to-left
reading on Hebrew and Arabic systems
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The title parameter holds the string displayed in thetitle bar of the dialog box. (If you don t specify
title, the application name is placed in the title bar.)

The helpfile argument is a string that identifies the Help file to use to provide context-sensitive Help
for the dialog box.

The context argument is the Help context number assigned to the appropriate Help topic.
The possible return values from M sgBox() appear in Table 4.3.

Table4.3

MsgBox()

return

values. ValueDescription

Constant

vbCancd 2 Cancel

vbAbort 3 Abort

vbRetry 4 Retry

vbignore 5 Ignore
vbYes 6 Yes
vbNo 7 No

The InputBox() Function

Y ou can use the InputBox() function to get a string of text from the user. Here s the syntax for this
function:

| nput Box(pronpt[, title] [, default] [, xpos] [, ypos] [, helpfile,
context])

The prompt argument is a string displayed as the message in the dialog box.

Thetitle argument is a string displayed in the title bar of the dialog box. (If you don t specify the
title, the application name is placed in the title bar.)

The default argument is a string displayed in the text box as the default response if no other input is
provided.

The xpos argument is a number that specifies (in twips) the horizontal distance of the left edge of
the dialog box from the left edge of the screen.

The ypos argument is a number that specifies (in twips) the vertical distance of the upper edge of
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the dialog box from the top of the screen.

The helpfile argument is a string that identifies the Help file to use to provide context-sensitive Help
for the dialog box.

The context argument is the Help context number assigned to the appropriate Help topic.

The InputBox() function returns the string the user entered.
Passing Forms To Procedures

Y ou can pass forms to procedures just as you would any object. Here, we ve set up a subroutine,
ColorWindowWhite(), to turn the background color of aform to white:

Sub Col or W ndowwhi t e( For nToCol or As Form

End Sub

In this case, we can simply refer to the form passed to this subroutine by the name we ve given the
passed parameter, FormToColor :

Sub Col or W ndowwhi t e( For mToCol or As Form
For nToCol or. BackCol or = RGB(255, 255, 255)
End Sub

Now you can pass aform to the Color WindowW hite() subroutine easily:

Private Sub Conmandl d i ck()
Col or W ndowhi te Me
End Sub

And that sall it takesto pass aform to a procedure.
Minimizing/Maximizing And Enabling/Disabling Forms From Code

To exert alittle more control over the windows in your programs, you can set the WindowState
property to maximize or minimize them. Here s how you set that property, and what those settings
mean:

" ONorma
" 1 Minimized
" 2 Maximized

Here s an example, where we minimize a form when the user clicks a button:
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Private Sub Commandl Cick()
W ndowState = 1
End Sub

Y ou can also set the Enabled property to enable or disable awindow (when it s disabled, it will
only beep if the user triesto give it the focus). Y ou set the Enabled property to True to enable a

window and to False to disable it.
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Chapter 5
Visual Basic Menus

If you need an immediate solution to:

Using The Visual Basic Application Wizard To Set Up Y our Menus
What Item Goes In What Menu?

Adding A Menu To A Form

Modifying And Deleting Menu Items

Adding A Menu Separator

Adding Access Characters

Adding Shortcut Keys

Creating Submenus

Creating Immediate ( Bang ) Menus

Using The Visual Basic Predefined Menus

Adding A Checkmark To A Menu Item

Disabling (Graying Out) Menu Items

Handling MDI Form And MDI Child Menus

Adding A List Of Open Windows To An MDI Form s Window Menu
Making Menus And Menu Items Visible Or Invisible
Creating And Displaying Pop-Up Menus

Adding And Deleting Menu Items At Runtime
Adding Bitmaps To Menus

Using The Registry To Store A Most Recently Used (MRU) Files List

In Depth

Everyone who uses Windows knows about menus they re those clever controls that
hide away lists of items until you want to make a selection, like the Visual Basic
File menu, which appearsin Figure 5.1. And, in fact, that s the design philosophy
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behind menus: rather than presenting the user with all possible controls at once,
menus hide their items until needed. Imagine a program with 50 buttons all over it
Save File, Save File As, Insert Object, Paste Special, and so on you d hardly have
space for anything else. That swhy menus are so popular: they present their
controls in drop-down windows, ready to use when needed.

Figure5.1 The Visua Basic File menu.

In this chapter, we re going to take alook at using menusin Visual Basic. Well
start with an overview of designing your menu system, including some
considerations that Microsoft has developed. Then we Il go to this chapter s
Immediate Solutions, seeing how to use the Visual Basic Menu Editor to create and
modify menus. We Il also see how to modify menus and the items they include from
code, when a program is running. And, of course, we || see some special topics, like
how to create a Most Recently Used (MRU) list of files and how to use Windows
functions to add bitmaps to menu items.

Well start our overview on Visua Basic menus now by taking alook at the parts of
amenu.

Menu Design Considerations

Every Windows programmer is familiar with the parts of a menu; for reference, they
appear in Figure 5.1. The menu names in a program appear in the menu bar usually
just under the title bar and when the user selects a menu, that menu opens, like the
Filemenuin Figure 5.1.

Each menu usually contains items arranged in avertical list. These items are often
grouped into functional groups with menu separators, or thin horizontal rules, as
shown in Figure 5.1. When the user selects a menu item (from the keyboard or with
the mouse), that item appears highlighted; pressing Enter or releasing the mouse
button opens that item.

Menu items can also be disabled (also called grayed out ), as shown in Figure 5.1.
A disabled item is not accessible to the user and does nothing if selected.

TIP: If your program presents the user with alot of disabled menu items, the user
may feel locked out and frustrated. To avoid such situations, many programs add or
remove menu items from menus at runtime, and we || see how to do that in this
chapter.

Access Characters And Shortcuts

Idedlly, each item should have a unique access character for users who choose
commands with keyboards. The user reaches the menu or menu item by pressing Alt
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key and the access character. The access character should be the first letter of the
menu title, unless another letter offers a stronger link; no two menus or menu items
should use the same access character.

Shortcuts are also useful to the user; these keys are faster than access charactersin
that the user only needs to enter a shortcut to execute the corresponding menu item.
For example, the New Project shortcut in Figure 5.1 is Ctrl+N.

Note also that an ellipsis (&) should follow names of menu items that display a
dialog box (Save As&, Preferences&, etc.) when selected. In addition, if you have
menus in the menu bar that execute a command immediately instead of opening a
menu, you should append an exclamation point to the menu s name, such as
Collate!

Designing Your Menus

A popular aspect of Windows isthat it gives the user acommon interface, no matter
what program they re using, and users have come to expect that. In fact, if it s hard
to learn a new, nonstandard Windows program, the user may well turn to a
Windows-compliant alternative, so it sagood ideato stick with the Windows
standards.

Most programs have a File menu first (at left) in the menu bar, followed by other
menus, like aView menu, a Tools menu, and so on, followed by a Help menu,
which usually appears last (and often at the extreme right in the menu bar). Users
expect to find certain standard items in particular menus; for alist of these items,
see What Item Goes In What Menu? in this chapter.

Microsoft recommends that you keep your menu item names short. For one thing, if
you want to release your application internationally, the length of words tends to
Increase approximately 30 percent in foreign versions, and you may not have
enough spaceto list al of your menu items. Microsoft also recommends that you
use the mnu prefix in code for menus, like mnuFile, and menu items, like
mnuFileOpen.

That completes our overview it stime to turn to the Immediate Solutions.
Immediate Solutions

Using The Visual Basic Application Wizard To Set Up Your Menus
Probably the easiest way to get a substantial menu system going in your program is
to design that program with the Visual Basic Application Wizard. The

menu-designing window that appears when you build an application with the
Application Wizard appearsin Figure 5.2.

Figure 5.2 Using the Application Wizard to design a menu system.
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Y ou can arrange, add, or remove menu items with the click of amouse. The
Application Wizard isnt for everyone, but it can create a very complete menu
system, as shown in Figure 5.3, where the File menu in the created application is
open.

Figure 5.3 An Application Wizard designed program s menu system.
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What Item Goes In What Menu?

The Testing Department gives you a call to ask why the Paste item in your new
application isin the View menu. You ask if they had a different menu in mind, and
they mention something about the Edit menu. How can you avoid such calls? With
the following lists.

Users expect to find certain standard itemsin certain menusif your programis
going to support those items. To start us off, here s the kind of item you might find
in the File menu (note that not all programs will use all these menus):

" New

" Open
Close

" CloseAll
' Save

" SaveAs

" SaveAll

' Properties
Templates
Page Setup
" Print Preview
" Print
Print Using
" Send

" Update

" Exit

TIP: Evenin programsthat dont handlefiles, it s not uncommon to see aFile
menu for one reason that s where the user expects the Exit item. Don t forget to add
an Exit item to your menu system (you can end a Visua Basic program using the
End statement, so this menu item is easy to implement).
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The Edit menu usually holds items like these:
" Undo

" Redo

' Cut

Copy

" Paste

" Paste Using

" Paste Specid

Clear

' Select All

" Find

Replace

' Bookmark

" Insert Object (unless you have a separate Insert menu)
The View menu has items like these:

' Toolbar

" Status Bar

" Refresh

' Options

The Window menu has items like these:

" New Window

' Cascade

Tile Windows
Arrange All

* Split

" List Of Windows

The Help menu hasitems like these:

" Help
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" Help Index

" Help Table of Contents
" Search for Help On

" Web Support

" About

Adding A Menu To A Form

The design processis complete it s time to start adding menus to your new program.
But when you sit down and start looking for the Menu tool in the toolbox, you find
that thereisn t one. Just how do you add a menu to aform?

Y ou use the Visual Basic Menu Editor. You |l get abasic introduction to the Menu
Editor here, and we Il use it throughout this chapter. To add a menu to aform, select
that form (that is, click on it), and open the Menu Editor by selecting the Menu
Editor in the Tools menu. Or, you can select itsicon in the toolbar (which has the
tool tip Menu Editor ). The Visual Basic Menu Editor appearsin Figure 5.4.

Figure5.4 TheVisua Basic Menu Editor.

Creating A New Menu

To create a new menu, you only have to provide two essential items: the caption of
the menu and its name. The Caption property holds the title of the menu, such as
File, and the Name property holds the name you Il use for that menu in code, such
as mnuFile.

Fill in the Caption and Name properties for your new menu now. Congratul ations
you ve created a new menu. Now it stime to add items to the new menu.

Creating A New Menu Item

We can add a new menu item, say, New, to the File menu we ve just created. To do
so, click the Next button in the Menu Editor, moving the highlighted bar in the box
at the bottom of the Menu Editor down one line. If you just entered new Caption
and Name values and left it at that, you d create a new menu, not a new menu item.
So click the right-pointing arrow button in the Menu Editor now to indent the next
item four spaces in the box at the bottom of the Menu Editor. Now enter the
Caption ( New ) and Name, ( mnuFileNew ) values for the new menu item.

The menu item you ve just created appears in the Menu Editor below the File menu
item and indented, like this:

File
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. New
This means that we now have a File menu with oneitemin it New.

That s how your menu system is displayed in the Menu Editor: as a series of
indented items. For example, here s how a File menu with New and Open items,
followed by an Edit menu with three items, Cut, Copy, and Paste, would look in the
Menu Editor:

File

.. New
... Open

Edit

.. Cut

... Copy
....Paste

Here s how to create a new menu system in the Menu Editor, step-by-step:

Enter the first menu s Caption and Name.

Click the Next button (or press Enter).

Click theright arrow to indent one level, making this next entry a menu item.
Enter the menu item s Caption and Name.

Click the Next button (or press Enter).

Repeat Steps 4 and 5 for all theitemsin the first menu.

Click the Next button (or press Enter).

Click the left arrow to outdent, making this next entry a menu.

© © N o g & w DN P

Enter the next menu s Caption and Name.

=
o

. Click theright arrow to indent one level, making this next entry a menu item.

[EEN
[EY

. Repeat Steps 4 and 5 for the itemsin this new menu.

[EEY
N

. Repeat Steps 7 through 11 for the rest of the menus in the program.

=
w

. Click on OK to close the Menu Editor.
14. Edit the code.

Y ou edit the code for menu items just as you do for other controls click the menu
item in the form under design (opening the item s menu if necessary). This opens
the menu item s event handler, like this:
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Private Sub mmuFi | eNew C i ck()

End Sub

Just add the code you want to execute when the user chooses this menu item to the
event handler procedure:

Private Sub mmuFi |l eNew O i ck()
LoadNewDoc
End Sub

And that sit now you ve added a menu system to your program.
Modifying And Deleting Menu Items

Y ou think the program is perfect, but the users are complaining that they dont like
having the Save Asitem in the Edit menu and want to move it to the File menu. Is
that possible?

Y es, using the Menu Editor. Y ou can rearrange, add, or remove items in your menu
with the Menu Editor, so open that tool now (as shown in Figure 5.4).

Inserting Or Deleting ItemsIn A Menu System

To add a new item to a menu, or a new menu to the menu system, select an itemin
the Menu Editor, and click the Insert button. This inserts a new, empty entry into
the menu just before the item you selected:

File

. New

. Open
Edi t

. Cut
.. .. Copy
....Paste
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Now just enter the new item s Caption and Name properties, and you re all set.

To remove amenu or menu item, just select that menu or item and click the Delete
button.

Rearranging ItemsIn A Menu System

Y ou can use the four arrow buttonsin the Menu Editor to move items up and down,
aswell asindent or outdent (that is, remove one level of indenting) menu items.
Here swhat the arrows do:

" Right arrow Indentsamenu item.

" Left arrow Outdents a menu item.

" Uparrow Movesthe currently selected item up one level.

" Down arrow Movesthe currently selected item down one level.

For example, to move the Save Asitem from the Edit menu to the File menu, just
select that item and keep clicking the up arrow button until the Save Asitemis
positioned as you want it in the File menu.

Adding A Menu Separator

Menus themselves allow you ways to group commands by function (File, Edit, and
so on). Often within a menu, however, it helps the user to group menu items by
function (Print, Print Preview, Page Setup, and so on). Y ou do that with menu
separators.

A menu separator is a horizontal rule that really only has one purpose to divide
menu items into groups (refer back to Figure 5.1). And using the Menu Editor, you
can add separators to your menus.

To add a menu separator, select an item in the Menu Editor and click Insert to create
anew item just before the item you selected. To make this new item amenu
Separator, just give use a hyphen (-) for its Caption property. Y ou must give all
menu items a name even if they don t do anything so give it adummy Name
property value as well, such as mnuSepar ator .

When you run the program, you |l see the menu separators in place, asin the menu
in Figure 5.5. Now we re adding menu item separators to our menus.

Figure5.5 A menu with menu separators.
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Adding Access Characters

The Testing Department s calling again: They like the menus you ve added to your
program, but there s the keyboard access issue. Theoretically, they say, users should
be able to use the keyboard for everything.

It stime to add access characters to your program. When the user presses the Alt
key and an access character, the menu item corresponding to that access character is
selected. How do you associate an access character with amenu or menu item? 1t s
easy just place an ampersand (&) in front of the character you want to make into the
access character in that menu or item s caption.

For example, if you had this menu system

File

.. New

....0QOpen
Edit

.. Cut

.. .. Copy
....Paste

you could make a letter in all menus or menu items into access characters by
placing an ampersand in front of it:

&Fil e

.. .. &New

....&0pen

&Edi t

.. .. &Cut

.. .. C&opy

....&Paste

Avoiding Access Character Duplication

Note in the previous exampl e that we have two items Cut and Copy in the Edit
menu that begin with C . That s a problem, because an access character must be
unigue at itslevel (where the level isthe menu bar for menus and a menu for menu
items). To avoid confusion (both to the user and to Visua Basic), we make o, the
second letter in Copy, the access character for that item.

The result of adding access characters to your menus at design time appearsin the
Menu Editor in Figure 5.6. At runtime, access characters appear underlined in
menus, as shown in Figure 5.7.
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Figure 5.6 Adding access characters.

Figure5.7 Access characters are underlined.

To use an access key, users first open the menu in which the item they want to
select appears (possibly using an access key, like Alt+F for the File menu), then
they press the Alt key and the access key.

Adding Shortcut Keys

One of the most powerful aspects of menus are shortcut keys single keys or key
combinations that |et the user execute a menu command immediately (without
having to open the menu the command is in, as you must do with access keys). Y ou
usually use function keys (although many PCs now go up to F16, it s best to limit
yourself to F1 through F10) or Ctrl key combinations for shortcut keys. For
example, the standard shortcut key for Select All is Ctrl+A, and entering that
shortcut selects al the text in a document.

Giving a menu item a shortcut key is very easy in the Menu Editor. Just open the
Menu Editor, select the item you want to give a shortcut key to (such asthe File
menu s New item in Figure 5.8) and select the shortcut key you want to use in the
Menu Editor box labeled Shortcut. (Note that to open the Menu Editor, the form
you re designing must be the active window in Visual Basic, not the code window.)
In Figure 5.8, we give the New item the shortcut Ctrl+N.

Figure 5.8 Setting a shortcut key.

That sall it takes now run the program, as shown in Figure 5.9. Y ou can see the
Ctrl+N at the right in the menu item named New we ve installed our menu shortcut.

Figure 5.9 Shortcut key in aprogram s menu.
Shortcut Key Standards

Windows conventions now include a set of standard shortcut keys that are supposed
to apply across most Windows applications. Here are the most common shortcut
keys (be very careful when using these key combinations for other purposes; your
users may expect the standard response):

" Ctrl+A Select All
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" Ctrl+B Bold

" Ctrl+C Copy

" Ctrl+F Find

' Ctrl+G GoTo
" Ctrl+H Replace
" Ctrl+1 Itaic

© Ctrl+J Justify
" Ctrl+N New

" Ctrl+ 0O Open

" Ctrl+P Print

" Ctrl+Q Quit

" Ctrl+SSave

" Ctrl+U Underline
" Ctrl+V Paste

" Ctrl+W Close
' Ctrl+ X Cut

" Ctrl+Z Undo

" F1lHep

Creating Submenus

Theemall isin and it s more praise for your program, AmazingWingDings (Deluxe
version). It s gratifying to read the great reviews but one user asksif you couldn t

place the Red, Green, and Blue color selections in the Edit menu into a submenu.
What are submenus, and how can you create them?
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What the user wants appears in Figure 5.10. Asyou can see in that figure, the
Colorsitem in the Edit menu has a small arrow at the right. This indicates that there
S a submenu attached to this menu item. Selecting the menu item opens the
submenu, as also shown in Figure 5.10. As you can see, submenus appear as menus
attached to menus.

Figure5.10 A program with a submenu.

Submenus | et you organize your menu system in a compact way, and adding them
to aprogram is simple. For example, let s say you started this way, with a Red,
Green, and Blue menu item in the Edit menu:

Edi t

. Cut
. Copy

.. Paste
. Red
. reen

.. Bl ue
.